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About This Manual 

Organization 
The ULTRIX Worksystem Software Sections lX and 8X Reference Pages 
provide descriptions of the X and DECwindows user commands and X 
window system maintenance commands that are supported in W orksystem 
Software. Similar to the reference pages in the ULTRIX Reference Pages, 
those provided in this manual are divided into separate sections: 

Section 1: Commands 

Describes the user commands that are available to all UL TRIX W orksystem 
Software users. 

Section 8: Maintenance 

Describes the maintenance commands that can be used specifically for the 
UL TRIX Worksystem Software. 

Format 
Each reference page has the following general format. 

Each has a title header consisting of the subject name and the appropriate 
section number. For example, the title header for the dxclock command 
from Section 1 is dxclock(1). 

The remaining subsections provide the specific information that is relevant to 
the topic. In general, the following subsection titles are used where 
appropriate: 

Name 
Lists the topic name and a short description of the entry. 

Syntax 
Provides the command syntax. Boldface indicates characters typed literally. 
A minus sign (-) indicates a command option and is typed as part of the 
option. Italics indicate variable information that you must specify. An 
ellipsis ( ... ) indicates that the preceding argument can be repeated. Square 
brackets [ ] enclose optional arguments. 

Arguments 
Describes the arguments you provide with the command. 



Description 
Describes the command function, usage, and syntax variations. 

Options 
Describes the use and effects of each option. 

Menus 
Describes the menus that may appear. 

Diagnostics 
Describes the diagnostic and error messages that may appear. In most cases, 
self-explanatory messages are not listed. 

Restrictions 
Describes all known command restrictions or limitations. 

X Defaults 
Describes the format for a resource specification in the . Xde fa ul t s file. 

Files 
Lists the related files that are either part of the command or used during 
execution. 

See Also 
Lists references to related reference page entries and to other documents. 
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dxcalc(1X) 

Name 
dxcalc - DECwindows interface to the calculator 

Syntax 
dxcalc [ options ] 

Description 

The dxcalc command displays a 27-function calculator with one memory 
location that is always visible. The dxcalc calculator has a maximum display 
of 15 digits. 

To press a button displayed in the dxcalc window, click on it with MBI (the 
left mouse button, unless you have redefined it). In addition, you can enter 
numbers by typing them in from the keyboard. To perform a function from 
the keyboard, check the key binding listed in the application's on-line help or 
in this reference page. 

Options 

-bd color 

-bg color 

-d dispname 

-display dispname 

-fg color 

Specifies the color of the window's border (color 
displays only). The default is specified by means of 
the Session Manager's Customize Windows dialog 
box. 

Specifies the color of the window's background 
(color displays only). The default is specified by 
means of the Session Manager's Customize 
Windows dialog box. 

Specifies the display screen on which dxcalc 
displays its window. If the display option is not 
specified, dxcalc uses the display screen specified by 
your DISPLAY environment variable. The display 
option has the format hostname:number. Using two 
colons (::) instead of one (:) indicates that DECnet is 
to be used for transport. The default is :0. For more 
information, see X( IX). 

This option is the same as the -d option. 

Specifies the color of the text (color displays only). 
The default is specified by means of the Session 
Manager's Customize Window dialog box. 
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-fn/ont 

-geometry 

Menus 

Specifies the font for calculator menus. (Key fonts 
are automatically scaled to match the size of the 
calculator.) The default font is menuI2. A font 
value specified in the .Xdefaults file overrides this 
option. 

Specifies the width, length, and location of the 
dxcalc window. If the geometry option is not 
specified, dxcalc uses default values. The geometry 
option has the format [width][xlength][x][y]. For 
more information about the screen coordinate 
system, see X( IX). 

The dxcalc application contains the following menus: 

File 
Edit 
Help 
Pop-up 

File Menu 

The File menu contains the following items: 

Save Geometry Saves the calculator's size and position, to use 
the next time you run the calculator. 

Use System Defaults Restores the use of the system default values 
for size and position. 

Quit Closes the dxcalc window. 

Edit Menu 

The Edit menu contains the following items: 

Undo Undoes the last keystroke or operation. 

Copy Copies the selected text onto the clipboard. 

Paste Pastes in text from the clipboard. 
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Help Menu 

The Help menu displays information about dxcalc. 

Pop-up Menu 

To display the dxcalc pop-up menu, place the pointer at any position in the 
dxcalc window and click MB2. This menu contains the following items: 

Undo 
Copy 
Paste 
Quit 

Key Bindings 

The dxcalc application has a specific set of key bindings that allow you to 
use the keypad for all mathematical functions. The built-in key bindings are 
as follows: 

numbers 

c 

ce 

Square root 

+ 

Multiplication 

Division 

The numbers on the keypad and the numbers in the 
number line map to themselves. 

Clears both the display and the accumulator. Maps 
to the C key and the Fl key. 

Clears the display. Maps to the E key and the F2 
key. 

Returns the square root of the value in the display. 
Maps to the Q keyboard key and the PF2 numeric 
keypad key. 

Adds the value in the display to the value in the 
accumulator. Maps to the plus symbol (+) in the 
number line and the comma key (,) in the keypad. 

Subtracts the value in the display from the value in 
the accumulator. Maps to the minus sign (-) in the 
number line and the minus sign in the keypad. 

Multiplies the value in the accumulator by the value 
in the display. Maps to the asterisk (*) and to the 
PF3 key. 

Divides the value in the accumulator· by the value in 
the display. Maps to the slash (/) key on the 
keyboard and the PFI key in the keypad. 
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Negation 

Percent 

Memory clear 

Memory minus 

Memory plus 

Memory recall 

Equals 

Decimal Point 

PI 

Inverse 

Sine 

Cosine 

Tangent 

1-4 Commands 

Changes the value in the display from positive to 
negative or from negative to positive. Maps to the n 
key. 

Maps to the percent (%) keyboard key and the PF4 
keypad key. 

Clears the contents of memory. Maps to the m key Ic 
key sequence and to the FI7 key. 

Subtracts the value in the display from the value in 
memory. Maps to the m key/- key sequence and to 
the FI8 key. 

Adds the value in the display to the value in memory 
and stores the result. Maps to the m key Iplus (+) key 
sequence and to the FI9 keypad key. 

Places the contents of the memory in the display. 
Maps to the m key Ir key sequence and to the F20 
key. 

Displays the result of the last operation (or series of 
operations). Maps to the Enter, Do, and Return 
keys. 

Inserts a decimal point into the number in the 
display. Maps to the period keys on the keyboard 
and keypad. 

Places the value for PI in the display. Maps to the p 
keyboard key. 

Inverts the next operation. Maps to the i and F3 
keys. 

Returns the sine of the value in the display. (If the 
inverse setting is on, returns the arcsine.) The angle 
is in degrees, radians, or gradients, according to the 
state of the degrees key. Maps to the s and F4 keys. 

Returns the cosine of the value in the display. (If the 
inverse setting is on, returns the arccosine.) The 
angle is in degrees, radians, or gradients, according 
to the state of the degrees key. Maps to the 0 and F5 
keys. 

Returns the tangent of the value in the display. (If 
the inverse setting is on, returns the arctangent.) The 



Log based 10 

Natural log 

y to the x 

Degrees 

Factorial 

lover x 

Random number 

X Defaults 

dxcalc(1X) 

angle is in degrees, radians, or gradients, according 
to the state of the degrees key. Maps to the t and F6 
keys. 

Returns the log (base 10) of the value in the display. 
(If the inverse setting is on, returns 10 to x.) Maps to 
the I key /0 key sequence and to the F7 key. 

Returns the natural log of the display. (If the inverse 
setting is on, returns e to x.) Maps to the I key In 
key sequence and to the F8 key. 

Returns the value in the accumulator raised to the 
power of the value in the display. (If the inverse 
setting is on, returns y to the minus x.) Maps to the 
circumflex (A) and FlO keys. 

Switches the measurement unit for trig functions 
among degrees, radians, and gradients. Maps to the d 
and Fl1 keys. 

Returns the factorial of the display (n*(n-l)*(n-
2) ... *1). Maps to the exclamation mark (1) and F12 
keys. 

Returns the reciprocal of the display. Maps to the 
tilde (,.,.) and Fl3 keys. 

Returns a random number between 1 and the 
display. Maps to the r and Fl4 keys. 

The dxcalc application reads the .Xdefaults file during startup and uses the 
appropriate resource specification to customize the appearance of the dxcalc 
window. The format for a resource specification in the .Xdefaults file is: 

[name*]resource: value 

name Specifies the application name or the name string that 
restricts the resource assignment to that application or to a 
component of an application. If this argument is not 
specified, the resource assignment is globally available to all 
X applications. 

resource Specifies the resource. 

value Specifies the value that is to be assigned to the resource. 
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Flies 

Because each toolkit-based application can consist of a combination of 
widgets (for example, push buttons and a scroll bar), you can form the name 
string by adding widget class and name identifiers to the string. For further 
information about adding class and name identifiers, see X(1X). 

For dxcalc, the available class identifiers are: 

Calc 
MenuBar 

For dxcalc, the available name identifiers are: 

sqrtFontFamily 
KeyFontFamily 

The general resources listed in X( IX) apply to dxcalc. 

The fonts used by dxcalc are specified by an asterisk (*). This is done so 
that a font family is choosen instead of a particular font. The asterisk (*) is a 
wildcard character that matches all font sizes. 

-/.Xdefaults 
/usr/lib/XII/app-defaults/DXcalc 

See Also 
X(1X), dxwm(1X), DECwindows Desktop Applications Guide 
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Name 
dxcalendar - DECwindows calendar program 

Syntax 
dxcalendar [ options] 

Description 

The dxcalendar command starts an on-line interactive calendar and 
appointment book. The calendar stores and organizes information about 
events, reminds you when the scheduled events are due to take place, and can 
automatically schedule events that repeat on a regular basis. 

When it first starts, dxcalendar creates a binary database file named 
.dxcalendar.dat in your home directory. 

The dxcalendar command displays calendar information by providing 
individual windows for a year, month, or day. By default, dxcalendar 
displays a window containing a month display with the current day enclosed 
in a box. 

To select a month or day, click on the appropriate name or number. To 
move backwards and forwards within one display type, use the scroll bars 
provided. To change from one display type to another, double-click on the 
appropriate item. For example, to show a year display, double-click on the 
year. 

For more information, see the DECwindows Desktop Applications Guide, 
click on the Help menu, or use the Help key. 

Options 

-bd color 

-bg color 

Specifies the color of the window's border (color 
displays only). The default is specified by means of 
the Session Manager's Customize Window dialog 
box. 

Specifies the color of the window's background 
(color displays only). The default is specified by 
means of the Session Manager's Customize Window 
dialog box. 
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-d dispname 

-display dispname 

-fg color 

-fnfont 

Restrictions 

Specifies the display screen on which dxcalendar 
displays its window. If the display option is not 
specified, dxcalendar uses the display screen 
specified by your DISPLAY environment variable. 
The display option has the format hostname:number. 
U sing two colons (::) instead of one (:) indicates that 
DECnet is to be used for transport. The default is 
:0. For more information, see X( IX). 

This option is the same as the -d option. 

Specifies the color of the text (color displays only). 
The default is specified by means of the Session 
Manager's Customize Window dialog box. 

Specifies the font. The default is 6x 10. 

Resource specifications in the .Xdefaults file have not yet been fully tested. 

X Defaults 

The dxcalendar application reads the .Xdefaults file during startup and uses 
the appropriate resource specification to customize the appearance or 
characteristics of its displayed dxcalendar window. The format for a 
resource specification in the .Xdefaults file is: 

[name*] resource: value 

name Specifies the application name or the name string that 
restricts the resource assignment to that application or to a 
component of an application. If this argument is not 
specified, the resource assignment is globally available to all 
X applications. 

resource Specifies the resource. 

value Specifies the value that is to be assigned to the resource. 

The available class identifier is dxcalendar. 

For more information, see X( IX). 
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Files· 
-/.Xdefaults 
-/.DXcalendar 
-/.dxcalendar.dwc 
/usr/liblX 11/app-defaults/DXcalendar 

See Also 
X(lX), dxwm(lX), DECwindows Desktop Applications Guide 
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Name 
dxcardfiler - DECwindows interface to the cardfiler 

Syntax 
dxcardfiler [ options] 

Description 
The dxcardfiler command displays an Index window that provides access to 
an electronic version of a set of 3x5 index cards. You can add, delete, 
rename, duplicate, save, read, search, and print these cards. By organizing 
your index cards into sets, called card files, you can keep one group of cards 
separate from another group. 

The cards, which can hold 4000 characters of text and 64K bits of DDIF 
image (for example dxpaint output), will appear on your screen to the right 
of the Index window. 

In addition, the dxcardfiler Index window contains a Help menu that, when 
selected, displays an appropriate help message. 

Options 

-bd color 

-bg color 

-d dispname 

1-10 Commands 

Specifies the color of the window's border (color 
displays only). The default is specified by means of 
the Session Manager's Customize Window dialog 
box. 

Specifies the color of the window's background 
(color displays only). The default is specified by 
means of the Session Manager's Customize Window 
dialog box. 

Specifies the display screen on which dxcardfiler 
displays its window. If the display option is not 
specified, dxcardfiler uses the display screen 
specified by your DISPLAY environment variable. 
The display option has the format hostname :number. 
Using two colons (::) instead of one (:) indicates that 
DECnet is to be used for transport. The default is 
:0. For more information, see X( IX). 



-display dispname 

-fg color 

-fnfont 

-geometry 

Index Window 

dxcardfiler ( 1 X) 

This option is the same as the -d option. 

Specifies the color of the text (color displays only). 
The default is black. 

Specifies the font for all windows except the index 
list box. The default font is menu12. The default is 
6xlO. 

Specifies the width, length, and location of the 
dxcardfiler window. If the geometry option is not 
specified, dxcardfiler uses default values. The 
geometry option has the format 
[width] [xlength] [x] [y]. For more information about 
the screen coordinate system, see X(1X). 

The index window lists the names of the current cards (you can open new or 
previously selected cards by choosing Open ... from the File menu). To select 
a card, place the pointer on the name of the card and click MBl (the left 
button unless you have redefined it). You can also search for specific cards 
by selecting the card window and choosing the search menu. Once you 

. select a card, you can manipulate it by using the items contained in the Card 
window menus. 

Th index window contains the following menus: 

File 
Search 
Card 

File Menu 

The File menu contains the following items: 

Open... Opens an existing card file that you specify. If 
the specified card file does not exist, 
dxcardfiler asks if you want to open a new 
database. If you confirm, dxcardfiler opens a 
new Index window. You can begin adding 
cards. If you try to open a card file without 
first saving any changes to a previously 
opened file, a dialog box appears asking you 
whether you want to save your changes. 
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Merge •.. 

Save 

Save As ... 

Print 

Print ..• 

Save Geometry 

Use System Settings 

Quit 

Search Menu 

Merges the contents of the current card file 
with another, resulting in a card file that 
combines and sorts the contents of both files. 
The card file whose contents are merged with 
the current card file remains unchanged. 

Saves the current card file. If a name has been 
specified previously, dxcardfiler uses that 
name. If a name has not been specified 
previously, dxcardfiler prompts for a new 
name. 

Saves the current card file under a name that 
you specify. 

Prints a representation of all cards in the index 
to the default printer. You can change the 
default printer by means of the Print... option. 

Prints the current card file to a device you 
specify. 

Saves the cardfiler's size and position, to use 
the next time you run the cardfiler. 

Restores the use of system defaults for the 
cardfiler's size and position. 

Closes the dxcardfiler window. If you have 
not saved any changes or additions to the 
current file, a dialog box appears asking 
whether you want to save your changes. 

The Search menu contains the following items: 

Search Index... Searches the index topics for a text string. Because 
dxcardfiler treats spaces as text, you can search for 
two or more words. A dialog box appears that 
prompts for the text string. Then, dxcardfiler 
searches the topics of all index cards in the file and 
displays the first card in your file containing the text 
string. 

Search Card... Searches the contents of each card in the file for a 
text string. A dialog box appears that prompts for 
the text string. Then, dxcardfiler searches all index 
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Find Next 

Card Menu 

dxcardfiler (1 X) 

cards in the file and displays the first card in your 
file containing the text string. 

Searches for the next occurrence of the searched for 
string. 

The Card menu contains the following item: 

Create Card... Opens an empty card in a Card window and displays 
a dialog box that prompts for the card name. After 
you type the card name, type any information 
belonging on the index card in the Card window. 

Card Window 

A Card window contains a Text window in which the body of the card can 
be created and edited. The Card window also contains buttons that allow you 
to move to the next or the previous cards. For more information about the 
editing commands that can be used in the Text window, see x(1X). The 
name of the card displayed is listed in the title bar of the Card window. A 
Card window contains the following menus: 

File 
Edit 
Search 
Card 
Previous 
Next 

File Menu 

The File menu contains the following items: 

Print Prints a representation of a specified card in the 
index to a device or DDIF file. If a device has been 
specified previously, dxcardfiler uses that device. If 
a name has not been specified previously, 
dxcardfiler prompts for a name. 

Print ... 

Include Image 

Prints the current card to a device you specify. 

Includes into a card an image from a DDIF image 
file, such as one created with dxpaint(1X)or 
printscreen. 
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Close Closes the Card window. 

Edit Menu 

The Edit menu contains the following items: 

Undo Undoes the last cut, copy, paste, or undo operation. 

Cut Cuts the selected text or image onto the clipboard. 

Copy Copies the selected text or image from the clipboard. 

Paste 

Clear 

Search Menu 

Pastes the contents of the clipboard at the cursor if it 
is text or into the image region if it is an image. 

Removes the selected text or image from the card. 

The Search menu allows you to search the stack of cards for a text string. 

Card Menu 

The Card menu contains the following items: 

Create Card... Opens an empty card in a Card window and displays 
a dialog box that prompts for the card name. After 
you type the card name, type any information 
belonging on the index card in the Card window. 

Duplicate Duplicates the currently selected card. 

Rename ••. 

Delete 

Undelete 

Next 

Previous 

Restore 

Previous Button 

Displays a dialog box that prompts for the new name 
under which to index the card. 

Deletes the current card. 

Restores the last deleted card. 

Displays the next card in the Card window. 

Displays the previous card in the Card window. 

Restores the card to its original unedited state. 

The Previous button lets you view the previous card. Hold down the button 
to search quickly through the stack of cards. 

1-14 Commands 



dxcardfiler (1 X) 

Next Button 

The Next button lets you view the next card. Hold down the button to search 
quickly through the stack of cards. 

X Defaults 
The dxcardfiler application reads the .Xdefaults file during startup and uses 
the appropriate resource specification to customize the appearance of the 
dxcardfiler window. The format for a resource specification in the 
.Xdefaults file is: 

[name*] resource: value 

name Specifies the application name or the name string that 
restricts the resource assignment to that application or to a 
component of an application. If this argument is not 
specified, the resource assignment is globally available to all 
X applications. 

resource Specifies the resource. 

value Specifies the value that is to be assigned to the resource. 

Because each toolkit-based application can consist of a combination of 
widgets (for example, push buttons and a scroll bar), you can form the name 
string by adding widget class and name identifiers to the string. For further 
information about adding class and name identifiers, see X(lX). 

For dxcardfiler, the available class identifiers are: 

CardFiler 
cardmainwindow 
MenuBar 
indexmainwindow 
VList 

The resources available for dxcardfiler are listed in X( IX). 

Each specification included in the .Xdefaults file for the translations resource 
modifies a key setting for the editor that dxcardfiler uses. For more 
information about key and mouse specifications in the .Xdefaults file, see 
x(1X). 
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Files 
..... /.Xdefaults 
/usr/liblX 11/app-defaults/DXcardfiler 

See Also 
X(1X), dxpaint(1X), dxwm(1X), DECwindows Desktop Applications Guide 
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Name 
dxclock - DECwindows interface to the clock 

Syntax 
dxclock [ options] 

Description 

The dxclock command displays a window that continuously displays the 
system date and time. The clock can display time values in military style (0 
through 23 hours) or in 12-hour AM and PM format. The dxclock window 
has an alarm and the following components: 

Analog region 
Digital region 
Date region 

Options 

-bd color 

-bg color 

-d dispname 

-display dispname 

-fg color 

Specifies the color of the window's border (color 
displays only). The default is specified by means of 
the Session Manager's Customize Window dialog 
box. 

Specifies the color of the window's background 
(color displays only). The default is specified by 
means of the Session Manager's Customize Window 
dialog box. 

Specifies the display screen on which dxclock 
displays its window. If the display option is not 
specified, dxclock uses the display screen specified 
by your DISPLAY environment variable. The 
display option has the format hostname:number. 
Using two colons (::) instead of one (:) indicates that 
DECnet is to be used for transport. The default is 
:0. For more information, see X(1X). 

This option is the same as the -d option. 

Specifies the color of the text (color displays only). 
The default is specified by means of the Session 
Manager's Customize Window dialog box. 
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-fnfont 

-geometry 

Specifies the font for all of the clock menus. (The 
analog and digital fonts are automatically scaled to 
match the clock size.) The default font is menu 12. 
This option is overriden by the .Xdefaults file. 

Specifies the width, length, and location of the 
dxclock window. If the geometry option is not 
specified, dxclock uses default values. The 
geometry option has the format 
[width][xlength][x][y]. For more information about 
the screen coordinate system, see X( IX) 

The dxclock window has one pop-up menu. To display this pop-up menu, 
position the pointer anywhere within the dxclock window and click MB2 
(the middle mouse button unless you have redefined it). This menu contains 
the following menu items: 

Settings... Displays the Settings dialog box that lets you 
specify the clock regions to display, tum on 
or tum off the use of 24-hour digital time, set 
the alarm, and enter a message that appears 
when the alarm goes off. You can also display 
this dialog box by placing the pointer at any 
position within the dxclock window and 
double-clicking MB 1. 

Save Settings 

Use System Settings 

Help 

Exit 

Restrictions 

Saves the clock's settings and its size and 
position, to use the next time you run the 
clock. 

Restores the use of system default values for 
the clock's settings, size, and position. 

Displays information about using the dxclock 
command. 

Closes the dxclock window. 

The system time cannot be changed while the clock is running. The dxclock 
window must be closed and reopened if the system time is changed. 
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X Defaults 

The dxcIock application reads the .Xdefaults file during startup and uses the 
appropriate resource specification to customize the appearance dxcIock 
window. A resource specification in the .Xdefaults file has the following 
format: 

[name*] resource: value 

name Specifies the application name or the name string that 
restricts the resource assignment to that application or to a 
component of an application. If this argument is not 
specified, the resource assignment is globally available to all 
X applications. 

resource Specifies the resource. 

value Specifies the value that is to be assigned to the resource. 

Because each toolkit-based application can consist of a combination of 
widgets (for example, push buttons and a scroll bar), you can form the name 
string by adding widget class and name identifiers to the string. For further 
information about adding class and name identifiers, see X(1X). 

For dxcIock, the available class identifiers is: 

Clock 

For dxcIock, the available name identifiers are: 

Digital 
FontFamily 

In addition to the general resources listed in X(1X), the resources available 
for dxcIock are: 

AlarmOn 

AlarmHour 

AlarmMessage 

AlarmMinute 

Specifies that the alarm be turned on. If set to zero, 
the alarm is not turned on. If set to 1, the alarm is 
turned on. The default is zero. 

Specifies the hour the alarm is to go off (0 to 23). 
The default is 12. 

Specifies the message to be displayed when the 
alarm goes off. The default is the string Alarm 
Message. 

Specifies the minute the alarm is to go off (00 to 
59). The default is 00. 
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Files 

AlarmPM 

AnalogOn 

DateOn 

DigitalOn 

militaryOn 

Specifies that the alarm is set for PM. If set to zero, 
the alarm is set for AM. If set to 1, the alarm is set 
for PM. The default is zero. 

Specifies whether the analog portion of the dxclock 
window is displayed. If set to zero, the analog 
portion is not displayed. If set to 1, the analog 
portion is displayed. The default is 1. 

Specifies whether the date portion of the dxclock 
window is displayed. If set to zero, the date portion 
is not displayed. If set to 1, the date portion is 
displayed. The default is 1. 

Specifies whether the digital portion of the dxclock 
window is displayed. If set to zero, the digital 
portion is not displayed. If set to 1, the digital 
portion is displayed. The default is 1. 

Specifies whether the digital portion of the dxclock 
window displays the date in 12-hour format or 24-
hour format. If set to zero, 12-hour format is used. 
If set to 1, 24-hour format is used. The default is 
zero. 

The fonts used by dxclock are specified by an asterisk (*). This is done so 
that a font family is choosen instead of a particular font. The asterisk (*) is a 
wildcard character that matches all font sizes. 

-/.Xdefaults 
-/.DXclock 
/usr/lib/Xl1/app-defaults/DXc1ock 
-./DXclock 

See Also 
X(lX), dxwm(lX), DECwindows Desktop Applications Guide 
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Name 
dxdb - DECwindows debugger 

Syntax 
dxdb [options] file [coredump] 

Description 

The dxdb debugger is a DECwindows utility that lets you debug a C 
program, view its source code, and fix bugs found in the code. It uses many 
of the same methods as the dbx( 1) debugger. 

Options 

file 

coredump 

-I dir 

Menus 

A C object file compiled with the -g option of the 
cc( 1) command. The -g option produces the 
appropriate symbol information in the object file. 

A core file that you can access through dxdb to 
examine the state of a program that crashed. 

Adds dir to the list of directories that dxdb searches 
when looking for source files. Normally, dxdb 
searches only in the current directory. 

When you invoke the debugger, dxdb displays the Control window. The 
menu bar of the Control window contains the following menus: 

• File 

• Control 

• Options 

• Windows 

• Functions 

File Menu 

The File menu lets you perform global actions affecting the entire debugging 
session. It contains the following items: 

Open ... Reads in a new source file. 
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Make/Restart Builds a new executable and restarts the debugger. 

Edit Edits a source file. 

Quit Terminates the dxdb session. 

Control Menu 

The Control menu controls program execution. It contains the following 
items: 

Run 

Step 

Skip 

Continue 

Stop 

Return 

Options Menu 

Runs the program. 

Runs the program in single- or multiple-line increments. 
You set the step count using the Step window (see Options 
Menu). 

Runs the program in single- or multiple-line increments 
but views all code of a subroutine as a single step. You set 
the skip count using the Skip window (see Options Menu). 

Restarts a program after a Stop command, a breakpoint, or 
a Skip or Step function. 

Stops execution of the program. 

Continues execution until the current procedure returns. 

The Options menu items create the following windows: 

Run... Lets you supply arguments to a program. The Run 
window consists of an input area and the following 
control buttons: 

Step ... 
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• Run with Argument 

• Run 

• Close 
To supply an argument to a program, enter it in the input 
area and click on the Run with Arguments button. To run a 
program without specifying an argument, click on the Run 
button. Clicking on the Close button quits the window. 

Specifies the line increment (step count) in which dxdb 
runs a program. The Step window consists of an input 
area, plus (+) and minus (-) accelerator buttons, and the 
following command buttons: 



Skip ... 

Windows Menu 
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• Step Count 

• Step Once 

• Close 

To set a step count, either click on the appropriate 
accelerator button until you reach the desired count or 
enter the count in the input area. Click on the Step Count 
button, and then return to the Control window and click on 
the Step button. The debugger executes the specified 
number of lines of code each time you click on the Step 
button. 

To return to single-step increments, use the Step Once 
button. 

Sets the number of lines (skip count) that dxdb skips when 
running a program. The Skip window consists of an input 
area, plus (+) and minus (-) accelerator buttons, and the 
following command buttons: 

• Skip Count 

• Skip Once 

• Close 

You set the skip count as you set the step count. However, 
if dxdb encounters a subroutine call when executing a 
skip, it executes the entire routine as a single skip and 
resumes the skip count when it returns from the call. 

The Windows menu items create the following windows: 

Assign ... Assigns a value to a specified variable. The Assign 
window consists of the following input areas: 

• Variable prompt 

• Value prompt 

• Assign button 

• Close button 

To assign a value to a variable, enter a variable in the 
Variable text field, enter a value in the Value text field, 
and click on the Assign button. 
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Breakpoints... Displays the current breakpoints and tracepoints. To delete 
a breakpoint or tracepoint, select it in the text and click on 
the Delete button. 

Dump... Displays the values of all currently active local variables. 
The debugger updates the contents of this window each 
time you stop execution of the program (using the Step, 
Skip, or Stop function, or by setting a breakpoint). 

Examine... Displays the values of specified variables. This window 
consists of the following areas: 

Stack 

Make ••. 

Functions Menu 

• Text area 

• Examine prompt 

• Add button 

• Delete button 

• Close button 

To examine a variable, enter its name in the Examine text 
field and click on the Add button. The debugger displays 
the variable's current value in the window's text area. 

To delete a variable from the Examine window, click on 
its name in the window's text area and then click on the 
Delete button. 

Lets you view elements of the program execution stack. 
The program that dxdb is running places an entry on this 
stack each time program control executes one of its 
routines. Each element on the stack contains the routine 
name and the parameters passed to that routine. The 
debugger updates this window each time you stop the 
execution of the program. 

Displays the output of the MakeIRestart command. The 
Restart Command field is executed when the MakeIRestart 
command is executed and can be edited to suit the 
program being debugged. 

The Functions menu contains the following items: 

Whatis Returns the data type of a variable. Select a variable 
currently displayed in the Source window and then choose 
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Which 
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Whatis from the Functions menu. Whatis returns the 
variable's data type in the following format: 

variable - routine.datatype variable; 

Returns a list of routines from which you can locate a 
variable. Select a variable from the Source window and 
then choose Whereis from the Functions menu. Whereis 
returns the variable's location in the following format: 

routine.variable routine. variable ... 

Returns the scope of the variable (local or global) that is 
currently active. Select a variable from the Source window 
and then choose Which from the Functions menu. Which 
returns the variable's scope in the following format: 

variable - rotuine function ... variable 

In addition to those pulldown menus, there are several pop-up menus: 

Control Pop-up Menu 

The Control pop-up menu duplicates the Control pull-down menu; it controls 
program execution. To invoke this menu, press MB2 on the Source Area. 

Examine Pop-up Menu 

The Examine pop-up menu lets you examine the value of variables, and set 
and delete breakpoints and tracepoints. To invoke this menu, press the Shift 
key and click MB2 in the Source Area. The menu items operate on text in 
the Source area. If you position the pointer over some text before invoking 
the menu, the menu options refer to that text. If there is no text under the 
pointer, dxdb uses text that is highlighted. The menu items are as follows: 

Print Prints the value of a variable in the text area. 

Print * 
Examine 

Examine * 

Prints the value of a variable treated as a pointer. 

Enters a variable in the Examine window. 

Enters a variable in the Examine window treated as a 
pointer. 

Delete Examine Removes a variable from the Examine window. 

Stop in Func Sets a breakpoint in the selected function. 

Trace in Func Sets a tracepoint in the selected function. 
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The Examine and Print options have submenus that let you view the values 
in hexidecimal notation. 

Breakpoints Pop-up Menu 

This menu lets you set and delete breakpoints. To invoke the menu, press 
MB2 in the Margin Area. All options operate on the text indicated by the 
pointer when you invoke the menu. The menu options are as follows: 

Set at Line Sets a breakpoint at the specified line. 

Set in Func Sets a breakpoint in the specified function. 

Global Sets a global breakpoint. 

Random Func Sets a breakpoint in any function in the program. 

Random Line Sets a breakpoint at any line in the program. 

Delete BP Deletes a breakpoint whose symbol is under the cursor. 

The Set at Line and Set in Func options have submenus that let you set 
conditional breakpoints. 

Tracepoints POP-Up Menu 

This menu lets you set and delete tracepoints. To invoke the menu, press 
Shift/MB2 on the Margin Area. All options operate on the text indicated by 
the pointer when you invoke the menu. The Tracepoint pop-up menu has 
the following items: 

Trace Global Sets a global tracepoint. 

Trace at Line Sets a tracepoint at the specified line. 

Trace in Func Sets a tracepoint in the specified function. 

Delete Trace Deletes a tracepoint whose symbol is under the cursor. 

X Defaults 

The dxdb debugger reads the .Xdefaults file during startup and uses the 
appropriate resource specification to customize the appearance or 
characteristics of its windows. The format for a resource specification in the 
.Xdefaults file is as follows: 

[natne*] resource: value 

natne Specifies the application name or, in the case of toolkit­
based applications, the name string that restricts the 
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resource 
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resource assignment to that application or to a component 
of an application. If this argument is not specified, the 
resource assignment is globally available to all X 
applications. 

Specifies the X resource. 

value Specifies the value that is to be assigned to the resource. 

Because each X-based application can consist of a combination of widgets 
(for example, push buttons and a scroll bar), you can form the name string by 
adding widget class and name identifiers to the string. For additional 
information about adding class and name identifiers, see X(lX). 

/usr/liblX 11lapp-defaultslDb 
- .Xdefaults 
core 

See Also 
X(1X), dbx(l), dxterm(1X) 
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Name 
dxdiff - DECwindows visual differences program 

Syntax 
dxdiff [ options] [filel file2 ] 

Arguments 

file 

Description 

Specifies the two files that are to be opened at startup. If 
you do not specify any file names, dxdiff lets you specify 
files after it has started up. 

The dxdiff application does a line-by-line comparison of two files and 
displays the differences between them. The contents of the two files are 
displayed in two text regions on either side of a central difference region. 
The differences between the files are displayed as highlighted text. The 
differences are connected by lines or filled polygons across the central 
difference region. Line numbers are optionally displayed at each end of the 
difference lines, to show where the differences occur within the files. The 
files must be ASCII text files. 

Options 

-bd color 

-bg color 

-d dispname 

-display dispname 
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Specifies the color of the window's border (color 
displays only). The default is black. 

Specifies the color of the window's background 
(color displays only). The default is white. 

Specifies the display screen on which dxdiff displays 
its window. If the display option is not specified, 
dxdiff uses the display screen specified by your 
DISPLA Y environment variable. The display option 
has the format hostname:number. Using two colons 
(::) instead of one (:) indicates that DECnet is to be 
used for transport. The default is :0. For more 
information, see X( IX). 

This option is the same as the -d option. 



-fg color 

-fnfont 

-geometry 

-sv 
+sv 

-sh 
+sh 

-dl 

+dl 

-In 

+In 

-Infg color 

Menus 

dxdiff{1X) 

Specifies the color of the text (color displays only). 
The default is black. 

Specifies the font used as the output font. The 
default font is times_bold12. 

Specifies the width, length, and location of the 
dxdiff window. If the geometry option is not 
specified, dxdiff uses default values. The geometry 
option has the format =[width][xlength][x][y]. For 
more information about the screen coordinate 
system, see X(1X). 

Disables slave vertical scrolling. 

Enables slave vertical scrolling. This is the default. 

Disables slave horizontal scrolling 

Enables slave horizontal scrolling. This is the 
default. 

Enables the display of filled polygons to connect 
areas of different text. 

Enables the display of lines to connect areas of 
different text. This is the default. 

Disables the display of line numbers in the 
difference region. This is the default. 

Enables the display of line numbers in the difference 
region. 

Specifies the foreground color for the line numbers 
in the difference box. The default is black. 

The dxdiff window contains the following menus: 

Files 
Options 
Differences 
Help 
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Flies Menu 

The dxdi f f Files menu contains the following menu items: 

Open Files... Calls up two Open ... dialog boxes, to allow you to 
specify the two files that you want to compare. The 
Dialog boxes are labelled leftfileselector:O and 
rightfileselector:O. You must select one file from 
each dialog box. 

Print 

Quit 

Options Menu 

Not implemented. 

Exits the current dxdiff session. If the session is the 
original one, all other dxdiff sessions and windows 
are closed. 

The Options menu contains the following menu items: 

Linked Vertical Scrolling On/Off 
The default is linked vertical scrolling. When linked 
vertical scrolling is on and you scroll one of the 
files, the other file is scrolled with it line for line. 
When linked vertical scrolling is off, one file can be 
scrolled independently of the other one. 

Linked Horizontal Scrolling On/Off 
The default is linked horizontal scrolling. 

Render Diffs As Lines/Render Diffs As Filled Polygons 
Displays either lines or filled polygons to connect 
the differences across the difference box. The 
default on startup is for lines to be displayed. 

Display Diff Line Numbers/No Diff Line Numbers 

Differences Menu 

Displays line numbers at each end of the lines that 
connect the differences. The default is off. If dxdiff 
cannot find a suitable font size for displaying the 
line numbers, this item is disabled. 

The Differences menu contains the following items: 

Do Differences Displays the differences between the two currently 
selected files. 
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Do Differences In New Opens a new dxdiff window to display the 
differences between the two currently selected files. 
The existing dxdiff window remains on the screen 
for reference. 

Help Menu 

The Help Menu is not implemented. 

Restrictions 

Printing is not supported. 

Help is not implemented. 

X Defaults 

The dxdiff application reads the .XdefauIts file during startup and uses the 
appropriate resource specification to customize the appearance or 
characteristics of its displayed dxdiff window. The format for a resource 
specification in the .XdefauIts file is: 

[name*]resource: value 

name Specifies the application name or the name string that 
restricts the resource assignment to that application or to a 
component of an application. If this argument is not 
specified, the resource assignment is globally available to all 
X applications. 

resource Specifies the resource. 

value Specifies the value that is to be assigned to the resource. 

For more information, see X(lX). 

Because each toolkit-based application can consist of a combination of 
widgets (for example, push buttons and a scroll bar), you can form the name 
string by adding widget class and name identifiers to the string. For further 
information about adding class and name identifiers, see X(1X). 

For dxdiff, the available class identifiers are: 

MenuBar 
Label 
Menu 
PushButton 
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Text 
Scrollbar 

For dxdiff, the available name identifiers are: 

DxDiff The application class name 

dxdiff 

dxdiffmaindisplay 

mainmenu 

leftfileselector 

rightfileselector 

filespulldown 

openfiles 

print 

quit 

optionspulldown 

slavevertical 

drawdiff 

drawlinenumbers 

The application name 

The entire display, which includes all of the 
components of the window 

The main menu bar, which includes the pull-down 
menus 

The file selection dialog box for selecting a file to be 
displayed in the left text display region 

The file selection dialog box for selecting a file to be 
displayed in the right text display region 

The Files pull-down menu 

The Open Files button on the Files menu 

The Print button on the Files menu 

The Quit button on the Files menu 

The Options pull-down menu 

The Slave Vertical Scrolling On/Off button on the 
Options menu 

The Display Diffs As Lines/Filled Polygons button 
on the Options menu 

The Display Line Numbers button on the Options 
menu 

differencespulldown The Differences pull-down menu 

dodifferences The Do Differences button on the Differences menu 

dodifferencesinnew The Do Differences In New button on the 
Differences menu 

textregiondisplay 

diffregion 
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The text region display, which includes both the left 
and the right text display regions, each of which 
include the file name bars, the vertical scroll bars, 
the push button region and the text panes 

The region where the lines connecting the 
differences are displayed 



filenamebar 

vscroll 

textdisplay 

displaymenu 

dxdiff(1X) 

The file name bars at the top of each text region 

The vertical scroll bars 

The region where the file contents are displayed 

The push button region at the bottom of each text 
display region 

nextdiff 

prevdiff 

Examples 

The Next Diff push button 

The Prev Diff push button 

Files 

To change the background color of the dxdiff text regions, add the following 
entry to your .Xdefaults file: 
dxdiff*textdisplay*background: blue 

To change the background color of the push button region at the bottom of 
the window, add the following entry to your .Xdefaults file: 
dxdiff*displaymenu*background: red 

-/.Xdefaults, /usr/lib/X 11/app-defaults 

See Also 
diff(1), dxwm(1X), X(1X), Guide to the dxdiff Visual Differences Program 
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Name 
dxfc - BDF to PCF font compiler for XII 

Syntax 
dxfc [options] ffile] 

Description 

The dxfc. font compiler reads a Bitmap Distribution Format (BDF) font from 
the specified . bdf file (or from standard input if no file is specified) and 
writes an XII portable compiled font (PCF) to standard output. 

Options 

-pI Force the glyph padding to a specific number. The legal values are 
1, 2, 4, and 8. 

-sf Force the scanline unit padding to a specific number. The legal 
values are 1, 2, and 4. 

-m Force the bit order to most significant bit first. 

-I Force the bit order to least significant bit first. 

-M Force the byte order to most significant bit first. 

-L Force the byte order to least significant bit first. 

-w Print warnings if the character bitmaps have bits set to one outside 
of their defined widths. 

- W Print warnings for characters with an encoding of -1; the default is 
to silently ignore such characters. 

-t Expand glyphs in "terminal-emulator" fonts to fill the bounding 
box. 

-i Don't compute correct ink metrics for "terminal-emulator" fonts. 

See Also 
X(lX), dxmkfontdir (IX) 
"Bitmap Distribution Format 2.1 " 
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Name 
dxmail- DECwindows mail program 

Syntax 
dxmail [ options] 

Description 
The dxmail command provides a window-oriented interface to the mh Mail 
Handler. The mh program must be installed on your system before you can 
use dxmail. 

When dxmail starts, it checks in your home directory for the file .mh_profile. 
If the file is there, dxmail reads and uses the configuration information that 
the file contains. If the file is not there, dxmail creates it and includes the 
minimum required default values. 

At startup, dxmail displays a window that consists of seven areas: 

Title Bar Displays window manager icons that allow you to 
move and resize the dxmail window and to shrink it 
to an icon. For more information, see dxwm(1X). 

Menu Bar Lists the available dxmail menus (for example, File 
or Edit). 

Folder Index Pane Lists your current folders. By defauit, dxmail puts 
your incoming mail in the inbox folder. When you 
receive new mail, dxmail draws a border around the 
inbox folder. Drafts of messages can be saved in the 
drafts folder and messages to be deleted can be 
placed in the wastebasket folder. To select a folder, 
click on the appropriate folder button. When a 
folder button is selected, dxmail highlights that 
button. To view the contents of a folder, double­
click on the appropriate folder button. 

Global Commands Pane 
Lists the general dxmail commands (for example, 
Read new mail or Create-Send). 

Folder Title Bar Lists the name of the currently opened folder. 

Message Index Pane Lists the messages in the currently opened folder. 
Initially, this window lists the messages contained in 
the inbox folder. 
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Message Commands Pane 

Options 

-bd color 

-bg color 

-bw pixels 

-d dispname 

-display dispname 

-fg color 

-fnfont 

-n name 

-rv 
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Lists those commonly used commands that affect the 
messages listed in the Message Index Pane. 
Dimmed commands are disabled. 

Specifies the color of the window's border (color 
displays only). The default is specified by means of 
the Session Manager's Customize Window dialog 
box. 

Specifies the color of the window's background 
(color displays only). The default is specified by 
means of the Session Manager's Customize Window 
dialog box. 

Specifies the width (in pixels) of the window's 
border. 

Specifies the display screen on which dxmail 
displays its window. If the display option is not 
specified, dxmail uses the display screen specified 
by your DISPLA Y environment variable. The 
display option has the format hostname:number. 
U sing two colons (::) instead of one (:) indicates that 
DECnet is to be used for transport. The default is 
:0. For more information, see X( IX). 

Is the same as the -d option. 

Specifies the color of the text in digital mode and the 
color of the tick marks in analog mode (color 
displays only). The default is specified by means of 
the Session Manager's Customize Window dialog 
box. 

Specifies the font used as the output font in digital 
mode. Any fixed-width font can be used. The 
default is 6x 13. 

Specifies the name that is to replace the program 
name. 

Reverses the default color values (for example, black 
becomes white and white becomes black). The 
default is On. 



-t title 

Main Window 

dxmail (1X) 

Specifies the title to be listed in the main window's 
title bar. 

Global commands displayed in the dxmail window are: 

Read new mail 

Create-Send 

Checks to see if any new mail has arrived. If new 
mail has arrived, dxmail adds the new mail to the 
inbox folder and displays the first message in the 
default Read window. If the default Read window 
does not exist, dxmail creates one automatically. If 
no new mail has arrived, dxmail displays a dialog 
box that says "No new mail." The dxmail program 
beeps only if you have selected the "Beep instead of 
putting up a No New Mail Dialog Box" option in the 
Customize window. The default is no beep. 

Displays a Create-Send window that allows you to 
compose a new message. 

To specify the specific message or messages to be affected by commands in 
the Message Index Pane or in one of the several dxmail menus, first select 
the message or messages. 

To select a single message, click MBI (the left mouse button, unless you 
have redefined it) on the message. To highlight a range of messages, you can 
follow one of two procedures: 

1. Place the pointer on the first message to be selected. 

2. Press MB 1. 

3. Drag the pointer to the last message to be selected. 

4. Release MB 1. 

Or: 

1. Place the pointer on the first message to be selected. 

2. Click MB 1. 

3. Place the pointer on the last message to be selected. 

4. Hold down the Shift key and click MB 1. 

To add a message to the current selection, follow this procedure: 

1. Place the pointer on the icon of the message to be included. 

2. Hold the Shift key and click MB 1. 
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To remove a message from the current selection, follow this procedure: 

1. Place the pointer on the icon of the message to be removed. 

2. Hold the Shift key and click MB 1. 

To view the contents of a message, place the pointer on the icon of the 
message and double-click MB 1. The contents of the message are displayed 
in a Read window. 

The selected messages are the same as the highlighted messages, if any. The 
current message is marked with a plus sign (+), except when it is open in a 
Read menu (when it is marked with an open envelope). The current message 
is the last message viewed in the default Read window within the current 
folder. 

Message commands displayed in the dxmail window are: 

Deliver mail 

Reply 

Forward 

Print 

Move 

Delete 

1-38 Commands 

Incorporates new mail into your inbox folder. 

Creates a Create-Send window in reply to the first 
selected message. 

Creates a Create-Send window whose body is 
initialized to be the contents of the selected 
messages. 

Prints the selected messages. 

Moves the message to the selected folder. However, 
dxmail does not remove the message from the 
original folder until you close and reopen the folder, 
select the Commit Changes menu item, or double­
click on the open folder name. For example, you 
can remove a message moved out of inbox by 
closing and reopening inbox, selecting Commit 
Changes, or by double-clicking on inbox. If the 
selected folder is the same as the viewed folder, this 
command just beeps. You can move the messages 
back to the current folder by selecting the Undo 
move/delete menu item. 

Places the selected messages in the wastebasket 
folder for deletion. However, dxmail does not 
remove the selected messages from the current folder 
until you close and reopen the original folder, select 
the Commit Changes menu item, or double-click on 
the folder name. You can move the messages back 
to their original folder by selecting the Undo 
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move/delete menu item. 

Menus 

Less commonly used functions are available only through the Menu bar. The 
Menu bar contains the following menus: 

File 
Edit 
Pick 
Create-Send 
Read 
Maintenance 
Customize 

File Menu 

Move Moves the message to the selected folder. However, 
dxmail does not remove the message from the 
original folder until you close and reopen the folder, 
select the Commit Changes menu item or double­
click on the folder name. If the selected folder is the 
same as the viewed folder, this command just beeps. 

Copy... Copies the selected messages to the selected folder. 

Extract... Creates a file from the selected message. 

Print Prints the selected messages. 

Open folder Opens the currently selected folder. 

Open folder in new Opens the currently selected folder in a new main 
window. 

Deliver mail Incorporates new mail into your inbox folder. 

Exit Closes the main dxmail window. If the main 
window being closed is the only main dxmail 
window on the screen, then invoking this menu item 
exits dxmail. 

Edit Menu 

Delete Places the selected messages in the wastebasket 
folder for deletion; if no messages are currently 
selected, this item is disabled. However, dxmail 
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Undo move/delete 

Select all 

Pick Menu 

does not remove the messages from the current 
folder until you close and reopen the original folder, 
select the Commit Changes menu item, or double­
click on the folder name. You can move the 
messages back to their original folder by selecting 
the "Undo move/delete" menu item. 

Undoes any move or delete operations for the 
selected messages; if no messages are currently 
selected, this item is disabled. Once you commit 
changes to messages by reopening the folder, 
selecting the Commit Changes menu item, or 
double-clicking on the folder name, you cannot undo 
the changes. 

Selects all messages from the Message Index pane. 

The Pick menu lets you select, define, and manipulate groups of messages. 
Groups of messages, called sequences, further organize messages within a 
folder. For example, you can create sequences that consist of all of the 
messages that meet some common criterion (such as those to or from a 
certain person, received on a certain date, pertaining to a certain subject, or 
containing a specific word). 

Message sequences and their names are specific to folders; therefore, the 
same sequence name can exist in multiple folders. In each folder, all 
messages belong to a predefined sequence called all. Only one sequence can 
be displayed at a time; its name is next to the folder name in the title bar 
above the message list, When you view messages, the next and previous 
messages are defined in relation to the current sequence. 

The Pick menu contains the following items: 

Pick from selected folder ... 
Displays the Pick dialog box, which lets you specify 
criteria for selecting messages from any folder and 
creating a new sequence. 

Pick from opened folder .•. 

Create new sequence ... 
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Displays the Pick dialog box, which lets you specify 
criteria for selecting messages from the current 
folder and creating a new sequence. 



Open sequence 

Add to sequence 

Remove from sequence 

Delete sequence 
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Lets you specify the name of a new sequence. The 
sequence does not contain messages until you 
explicitly add some. The sequence name must begin 
with an alphabetic character and should not contain 
any non-alphanumeric characters (such as 
punctuation marks). 

Displays the last specified sequence or one that you 
select from the submenu. This item is disabled until 
the folder contains sequences other than all. 

Adds selected messages to a sequence that you 
select from the submenu. This item is disabled until 
the folder contains sequences other than all. 

Removes selected messages from a sequence that 
you select from the submenu. This item is disabled 
until the folder contains sequences other than all. 

Removes a sequence that you select from the 
submenu. The messages themselves are not deleted; 
they are still part of the folder's all sequence, 

The Create-Send menu contains the following items: 

New message Displays a Create-Send window that allows you to 
compose a new message. 

File 

Reply 

Forward 

Use as comp 

Displays the File Selection dialog box, which lets 
you send an existing file as a mail message. Once 
the File Selection dialog box is dismissed, dxmail 
displays a Create-Send window whose body is the 
specified file. 

Creates a Create-Send window in reply to the first 
selected message. 

Creates a Create-Send window that contains the 
contents of the selected message or messages. 

Creates a Create-Send window that contains the 
contents of the selected message. This menu item is 
often used to compose a new message with the 
contents of a message previously saved in the drafts 
folder. 
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Read Menu 

The Read menu contains the following items: 

In new Displays the selected message in a new Read 
window, regardless of whether a default Read 
window is already displayed. 

In default Displays the selected message in the default Read 
window. If a Read window is not displayed, dxmail 
creates a new Read window automatically. You can 
also invoke this command by double-clicking on the 
envelope icon for the appropriate message. 

In window # Displays a submenu that lets you display the 
selected message in one of several already displayed 
Read windows. 

New mail 

New mail in new 

Maintenance Menu 

Checks to see if any new mail has arrived. If new 
mail has arrived, dxmail incorporates the new mail 
and displays the first message in the automatically 
created default Read window. If no new mail has 
arrived, dxmail displays a dialog box that says "No 
new mail." The dxmail program beeps only if you 
have selected the "Beep instead of putting up a No 
New Mail dialog box" option in the Customize 
Window. The default is no beep. 

Checks to see if any new mail has arrived. If new 
mail has arrived, dxmail incorporates the new mail 
and displays the first message in a new Read 
window that is created automatically. If no new 
mail has arrived, dxmail displays a dialog box that 
says "No new mail." The dxmail program beeps 
only if you have selected the "Beep instead of 
putting up a No New Mail dialog box" option in the 
Customize Window. The default is no beep. 

The Maintenance menu contains the following items: 

Create folder... Creates a new folder and displays a dialog box that 
prompts for the new folder name. 

Empty wastebasket Deletes the messages previously placed in the 
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wastebasket folder with the Delete command. 

Delete folder... Deletes the selected folder and displays a Caution 
dialog box that prompts for verification. 

Commit changes Removes from the message list of the current folder 
any message that you previously marked to delete or 
move. When you close and reopen a folder or 
double-click on a folder name, dxmail invokes this 
command automatically. 

Renumber messages Renumbers the messages in the viewed folder 
starting from 1 and incrementing by 1 for each 
following message. 

Sort by date Sorts the messages in the folder into increasing order 
by date. 

Rescan folder Causes dxmail to check and make sure its 
information about the folder is correct. This 
command can be useful if you have invoked mh 
commands directly from the command line while 
dxmail is running. 

Customize Menu 

The Customize menu contains the following items: 

Modify mail profile Displays the Customize dialog box, which lets you 
modify characteristics of dxmail. The customize 
options are: 

Skip to next message upon deleting current one. 

Skip to next message upon moving current one. 

Commit changes in a folder upon closing it. 

Renumber messages in a folder after every commit. 

Put deleted messages into wastebasket instead of 
deleting immediately. 

Incorporate new messages when invoking Show 
Unopened Buttons 

Affect the current message if no messages are 
selected. 
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Read Windows 

Beep instead of putting up a No New Mail dialog 
box. 

Most Read window commands are the same as the message commands by 
the same name. However, the Read window commands affect the viewed 
message instead of the selected message, and there are three additional 
commands: 

Next 

Previous 

Close 

Displays the message after the message displayed 
currently. 

Displays the message before the message displayed 
currently. 

Closes the read window. 

Less commonly used functions are available only through the menu bar. The 
menu bar contains the following menus: 

File 
Edit 
Sequences 
Create-Send 
Read 

File Menu 
File menu items unique to the Read window are as follows: 

Make default window Specifies that the current Read window is the default 
Read window. 

Close Closes the Read window. 

Edit Menu 
Edit menu items unique to the Read window are as follows: 

Select all Selects all text displayed in the Read window. 

Edit message 

Save changes 
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Specifies that the message in the Read window can 
be modified. 

Saves any changes made to the message displayed in 
the Read window after invoking the Edit message 
menu item. 



Read Menu 

Next selected 

Previous selected 

N ext in folder 

Previous in folder 

Create-send Windows 
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Displays the next message selected from the main 
dxmail window in the current Read window. 

Displays the previous message selected from the 
main dxmail window in the current Read window. 

Displays the next message listed in the main dxmail 
window in the current Read window. 

Displays the previous message listed in the main 
dxmail window in the current Read window. 

The buttons associated with Create-Send windows are: 

Close Closes the Create-Send window without taking any 
further action. If changes have been made, dxmail 
displays a Caution dialog box prompting for 
confirmation or cancellation. 

Reset 

Save 

Send 

Clears the Create-Send window. 

Saves the message contained in the Create-Send 
window in the drafts folder. You can later view, edit, 
and send the message with the Use as comp 
command. 

Sends the message contained in the Create-Send 
window. If any errors appear in the message header, 
dxmail displays a mail message containing this 
composition and a description of the error. The 
Send command does not close the Create-Send 
window. 

The menu bar in a Create-Send window contains the following menus: 

File 
Edit 

File Menu 

Send 

Save 

Extract. .. 

Performs the same function as the Send button. 

Performs the same function as the Save button. 

Copies a message to a file. 
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Include file ••• 

Reset 

Invoke dxvdoc 

Quit 

Edit Menu 

Inserts a file into the message. 

Performs the same function as the Reset button. 

Executes the CDA Viewer on the current message. 
This item is no longer available, because the dxmail 
application can display DDIF messages in the Read 
window. 

Performs the same function as the Close button. 

Select Selects all text displayed in the Create-Send window. 

Converting Old Mail Folders 
If you have been using the mail (1) program to read your mail, you can 
convert your existing folders into dxmail folders with the following 
command: 

inc +foldername -file filename 

foldername 

filename 

Specifies the name that is to be used for the dxmail folder. 

Specifies the name of the existing mail folder. 

Note that you must run inc to access mail if you have been using the 
Berkeley·mail handler. For more information, see inc(1mh). 

Mail Aliases 

The dxmail command does not use your .mailrc file in your home directory. 
Therefore, dxmail does not use the user mail aliases that you have defined in 
that file. However, dxmail does make use of the global alias files that 
sendmail uses. 

To define an alias file to be used with dxmail, follow this procedure: 

1. Create the Mail directory and a skeleton .mh_profile file by invoking 
dxmail. This skeletal .mh_profile will contain the following line: 

Path: Mail 

2. Edit the .mh_profile file to add the following three lines: 

ali: -alias aliases 
send: -alias aliases 
whom: -alias aliases 
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3. Create an alias file in your Mail directory with the name specified in 
these lines. 

4. In your alias file, add lines in the following format: 

alias: person 1, person2, .... 

The person to whom you assigned an alias can have another alias, and you 
can mix previously defined aliases and people on the same line. However, 
because the file is read from top to bottom, you must make sure that aliases 
used in other aliases have already been defined in the file. 

X Defaults 

The dxmail application reads the .Xdefaults file during startup and uses the 
appropriate resource specification to customize the appearance or 
characteristics of its displayed dxmail window. The format for a resource 
specification in the .Xdefaults file is: 

[name*] resource: value 

name Specifies the application name or the name string that 
restricts the resource assignment to that application or to a 
component of an application. If you do not specify this 
argument, the resource assignment is globally available to all 
X applications. 

resource Specifies the resource. 

value Specifies the value that is to be assigned to the resource. 

For more information, see X(1X). 

Because each toolkit-based application can consist of a combination of 
widgets (for example, push buttons and a scroll bar), you can form the name 
string by adding widget class and name identifiers to the string. For further 
information about adding class and name identifiers, see x( IX). 

For dxmail, the available class identifiers are: 

AttachedDialogBox 
CautionBox 
Command 
Dialog 
Form 
Label 
MainWindow 
Menu 
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Menubar 
Message 
Pane 
Pulldown 
Pushbutton 
Scroll 
ScrollWindow 
Text 
Toggle 

For dxmail, the available name identifiers are: 

compButtons 
confirm 
createS end 
customize 
ddifHeaders 
dxmail 
folderArea 
folderCommandBar 
folders 
innerFolderArea 
innerMsgArea 
messageArea 
messageButtonsArea 
messageCommandBar 
messagePaneLabel 
messageText 
pick 
prompt 
read 
titlebar 
toc 
tocButtons 
tocform 
view Buttons 
workArea 

In addition to the general resources listed in X(1X), the resources available 
for dxmail are: 

send.geometry 
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Specifies the initial geometry (window size and 
screen location) for the Create-Send window. For 
more information about the geometry specification 



main.geometry 

read.geometry 

pick.geometry 

PrintCommand 

dxmail (1X) 

and screen coordinate system, see x(1X). 

Specifies the initial geometry (window size and 
screen location) for the main dxmail window. 

Specifies the initial geometry (window size and 
screen location) for the Read window. 

Specifies the initial geometry (window size and 
screen location) for the Pick window. 

Specifies the command to be executed to print a 
message. (Standard out and standard error must be 
redirected explicitly.) The default is 
Ipr > /dev/null 2 > /dev/null. 

Each specification included in the .Xdefaults file for the translations resource 
modifies a key setting for the editor that dxmail uses. For more information 
about key and mouse specifications in the .Xdefaults file, see X(1X). 

Restrictions 

Files 

The dxmail application requires Version 6 of mho If a line in the .mh_profile 
starts with Current-Folder, you have been using Version 4 or earlier. To 
convert to Version 6, remove that line. For more information, refer to 
rnh(1mh.) 

Printing support is minimal. 

Sequence names and message lists together cannot exceed 1024 characters. 
In practice, this means that sequences can have a maximum of 200 messages. 

-1.Mail 
-I.mh_profile 
-1.Xdefaults 
-/Mail/* 

See Also 
X(1X), dxwm(1X), mh(1mh), inc(1mh), DECwindows Desktop Applications 
Guide 
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Name 
dxmkfontdir - Create a list of fonts for the X server. 

Syntax 
dxmkfontdir [directory-names] 

Description 
The dxmkfontdir command creates files that list font names and the font 
files to which the names correspond, for use when the X server starts up. In 
each directory specified as a command argument, dxmkfontdir creates the 
directory's list of fonts and places it in a file called fonts.dir. If you omit 
arguments, dxmkfontdir creates a fonts.dir file for the current directory. 

The fonts.dir file lists each font file and gives the name of the font in that 
file. To obtain font names, dxmkfontdir searches the files in the directory 
for a property named FONT. If the FONT property is absent, dxmkfontdir 
uses the names of PCF (.pcf), BDF (.bdf), and compressed BDF (.bdf.Z) 
files, omitting their suffixes. If a font exists in multiple fonnats, the PCF 
format is used. 

When the X server starts up, it looks for a fonts.dir file in each font directory 
in the font path. It also looks for a fonts.alias file in each directory. 

Font Aliases 
You can create or edit the fonts.alias file to assign new names to existing 
fonts. X clients can then use the alias names to request fonts from the server. 
A font alias file can be in one or any number of directories in the font path. 
It consists of two columns, separated by white space. The first column lists 
aliases; the second column contains font name patterns. Aliases can 
reference fonts in directories other than the one in which the alias file exists. 

To embed white space in the alias name or the font name, enclose the name 
in quotation marks (""). To embed quotation marks (or any other 
characters), precede them with a backslash O. The following are sample 
entries from a fonts.alias file: 
courierlO 
/udir/sally/fonts/courier/10.pcf 
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"-adobe-helvetica-bold-o-norma 
24-240-15-75-p-104-1508859-1" 
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If the fonts.alias file contains the string FILE_NAMES_ALIASES alone on a 
line, each file name in the directory (without its .pcf suffix) is automatically 
translated as a font name alias. For example, a file named courierlO.pcf 
would have the font name alias courierlO. 

See Also 
X(1X), dxfc(1X) 
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Name 
dxnotepad - DECwindows text editor 

Syntax 
dxnotepad [ options ] [file ] 

Arguments 

file 

Description 

Specifies a file to open at startup. If you omit the file 
name, you can open or create a file from within 
dxnotepad. 

The dxnotepad command displays a window in which you can edit a file or 
a text buffer that you can later save as a file. At startup, the dxnotepad 
window consists of the following three areas: 

Title Bar Displays the name of the window, the name of the 
file currently being edited, and window manager 
buttons that move and resize the window and shrink 
the window to an icon. For more information, see 
dxwm(1X). 

Menu Bar 

Edit Window 

Options 

-bd color 

-bg color 

-d dispname 
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Lists the available dxnotepad menus. 

Displays the text that you are editing or creating. 

Specifies the color of the window's border (color 
displays only). The default is specified by means of 
the Session Manager's Customize Window dialog 
box. 

Specifies the color of the window's background 
(color displays only). The default is specified by 
means of the Session Manager's Customize Window 
dialog box. 

Specifies the display screen on which dxnotepad 
displays its window. If the display option is not 
specified, dxnotepad uses the display screen 
specified by your DISPLA Y environment variable. 



-display dispname 

-fg color 

-fnfont 

-geometry 

Menus 
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The display option has the format hostname :number. 
Using two colons (::) instead of one (:) indicates 
that DECnet is to be used for transport. The default 
is :0. For more information, see X(1X). 

s the same as the -d option. 

Specifies the color of the text in digital mode and the 
color of the tick marks in analog mode (color 
displays only). The default is specified by means of 
the Session Manager's Customize Window dialog 
box. 

Specifies the font used as the output font in digital 
mode. Any fixed-width font can be used. The 
default is 6xlO. 

Specifies the width, length, and location of the 
dxnotepad window. If the geometry argument is 
not specified, dxnotepad uses default values. The 
geometry option has the format 
[width][xlength][x][y]. For more information about 
the screen coordinate system, see X(lX). 

The dxnotepad window contains the following menus: 

File 
Edit 
Search 
Navigate 
Customize 

File Menu 

The File menu contains the following items: 

New Creates a new dxnotepad window. 

Open... Displays a dialog box that lets you specify the 
file to open. 

Open Selected 

Include ... 

Opens the file whose name has been selected 
in any application window on the screen. 

Displays a dialog box that lets you specify a 
file to write into the current buffer. The 
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Save 

Save As ••• 

Revert 

Quit 

Exit 

Edit Menu 

included file appears at the cursor's current 
position. 

Saves the contents of the Edit window in a 
file. If the file is untitled when Save is 
selected, dxnotepad displays a dialog box that 
prompts for the file name. 

Automatically displays a dialog box that 
prompts for the file name under which to save 
the contents of the buffer. 

Cancels all edits made since the last time 
dxnotepad saved edits. Edits are saved when 
you choose the Save menu item from the File 
menu and when you exit from an editing 
session. 

Ends the current editing session without 
saving changes and closes the dxnotepad 
window. 

Ends the current editing session, saving the 
modified text in the output file. 

The Edit menu contains the following items: 

Undo Undoes the last edit. Each time you select this 
menu item, each previous edit is undone. 

Redo Redoes the last edit. Each time you select this 
menu item, each edit that has been undone is 
redone. 

Undo ••• 

Cut 

Copy 

Paste 
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Displays the Undo dialog box that allows you 
to undo and redo sequences of edits. 

Removes text selected in the Edit window and 
moves it to the clipboard. This text can be 
retrieved with the Paste menu item. 

Copies text selected from the Edit window to 
the text buffer. You can retrieve this text with 
the Paste menu item. 

Inserts text previously cut or copied to the 
clipboard. 



Clear 

Select All 

Filter Selection ... 

Fill 

Sort 

Indent+4 

Indent-4 

Search Menu 

dxnotepad ( 1 X) 

Deletes selected text without copying it to the 
clipboard. 

Marks the entire buffer as the current 
selection, as if you had selected it with the 
mouse and pointer. 

Displays a dialog box in which you can 
specify an ULTRIX command through which 
to process text selected from your dxnotepad 
buffer. The command operates on the text and 
writes the output to the original location in the 
buffer. 

Reorganizes selected text so that the maximum 
number of whole words fits within an 80 
character line width, inserting carriage return 
characters at the end of each 80-character line. 
If your dxnotepad window width is less than 
80 characters, the fill operation can leave some 
lines broken, where the carriage return occurs. 

Sorts the selected text in ascending 
alphanumeric order, as if by executing the 
UL TRIX sort command. 

Moves the left margin for a selected block of 
text four columns to the right. 

Moves the left margin for a selected block of 
text four columns to the left. 

The Search menu contains the following items: 

Next Selected Searches from the current insertion point to 
the end of the file for the next occurrence of a 
string selected from any window on the 
screen. 

Previous Selected 

Next ..• 

Searches from the current insertion point to 
the beginning of the file for the next 
occurrence of a string selected from any 
window on the screen. 

Displays a dialog box that prompts for a 
search string. The Next button finds the next 
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Previous ••. 

Next IncrementaI. .• 

occurrence of the string (moving forward); the 
Previous button finds the previous occurrence 
of the string (moving backward). The default 
direction is forward. 

Displays a dialog box that prompts for a 
search string. The Next button finds the next 
occurrence of the string (moving forward); the 
Previous button finds the previous occurrence 
of the string (moving backward). The default 
direction is backward. 

Searches from the initial search position to the 
bottom of the buffer for a string of characters. 
You can change the search string during the 
operation; each time you add or delete a 
character, dxnotepad returns to the initial 
position and highlights the next occurrence of 
the pattern now specified. 

Previous Incremental... Searches from the initial search position to the 
top of the buffer for a string of characters. 
You can change the search string during the 
operation; each time you add or delete a 
character, dxnotepad returns to the initial 
position and highlights the next occurrence of 
the pattern now specified. 

Replace Once... Displays a dialog box in which you enter an 
existing string and the string that you want to 
substitute. Searching from the insertion point 
forward, dxnotepad finds the next occurrence 
of the existing string. Click on the Yes button 
to replace the string and move to the next 
occurrence; click on the No button to skip to 
the next occurrence without making the 
replacement. 

Replace Within Selected Area 

Replace All .•• 
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Displays a dialog box in which you enter an 
existing string and the string that you want to 
substitute. The operation replaces all 
occurrences of the string within a selected 
block of text. 

Displays a dialog box in which you enter an 
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existing string and the string that you want to 
substitute. The operation replaces all 
occurrences of the string in the buffer. 

The Navigate menu contains the following items: 

Go to Top Moves the cursor to the top of the buffer. 

Go to Bottom Moves the cursor to the bottom of the buffer. 

Go to Selected Line Number 
Moves the cursor to the line whose number 
has been selected somewhere on the screen. 

Split View Divides the current view of the file into two 
views of that file. The first time you use this 
option, it splits the window into two views. 
Each view has its own scroll bars, so that you 
can work with two sections of the file at once. 
Further splits affect the view in which the 
cursor is active. 

Delete View Removes the view in which the cursor is 
active. 

Customize Menu 

The Customize menu contains the following items: 

Case Sensitive Searches 

Word Wrap 

Specifies whether dxnotepad distinguishes 
between uppercase and lowercase occurrences 
of text characters when searching for a string. 
When the button is set to On, a search finds all 
occurrences of a character. When the button is 
set to Off, a search finds only occurrences 
whose case matches the case in which you 
enter the search string. 

Specifies whether dxnotepad automatically 
starts a new line when you reach the right 
margin. When the button is set to On, word 
wrapping is automatic. When the button is set 
to Off, you must press the Return key at the 
end of each line. Note that dxnotepad does 
not insert carriage return characters as it wraps 
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Font 

Save Attributes 

Restore Attributes 

Journals 

the line; with word wrapping on, you can 
create a line that looks like a paragraph in 
your dxnotepad edit window, but that a 
printer interprets as a single long line. 

Displays a dialog box in which you choose 
font attributes and see a sample of the 
resulting font; the Apply button applies the 
font you select to your buffer. 

Saves the values that you specified for options 
on the Customize menu. These values are 
stored in the file .notepad.dat in your home 
directory; they will be used the next time you 
invoke dxnotepad. 

Restores the last saved values for options on 
the Customize menu. 

The dxnotepad editor records your edits in a journal file. When you save 
the file you are editing, the journal file is deleted. If an editing session 
terminates unexpectedly (due to a system crash, for example), the edits 
recorded in the journal file can be restored. 

When you attempt to edit a file whose journal file still exists, the Recover 
dialog box asks whether to apply the previous edits to the input file. Click 
on the OK button to restore the edits; click on the No button to forego 
applying the edits and delete the journal file. 

If an editing session is interrupted before you have saved the editing buffer as 
a file and assigned it a file name, dxnotepad assigns the journal file under a 
name based on your process number, with the suffix JNL (unless you have 
changed the default name, using a dxnotepad resource). 

To recover, first locate the journal file. You can recognize it in your 
directory because it has the form of AAAXXXXXXCCC, where AAA is your 
journalNamePrefix, XXXXXX is a unique number for this session (derived 
from your process ID), and CCC is your journalNameSuffix. Invoke 
dxnotepad, specifying an input file whose name is the number portion of the 
default journal file name. A dialog box asks whether to recover the crashed 
session. To restore the edits, answer yes. 

For information about specifying the journalNamePrefix and the 
journalNameSuffix, see the X DEFAULTS section. 
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Restrictions 
Large numbers of certain edit functions tend to degrade performance over 
time. If there is a noticeable decrease in response time, save the file; saving 
a file resets dxnotepad' s internal state. 

X Defaults 

The dxnotepad application reads the .Xdefaults file during startup and uses 
the appropriate resource specification to customize the appearance or 
characteristics of its displayed dxnotepad window. The format for a 
resource specification in the .Xdefaults file is: 

[name* ] resource: value 

name Specifies the application name or the name string that 
restricts the resource assignment to that application or to a 
component of an application. If this argument is not 
specified, the resource assignment is globally available to all 
X applications. 

resource Specifies the resource. 

value Specifies the value that is to be assigned to the resource. 

Because each toolkit-based application can consist of a combination of 
widgets (for example, push buttons and a scroll bar), you can form the name 
string by adding widget class and name identifiers to the string. For further 
information about adding class and name identifiers, see X(1X). 

For dxnotepad, the available class identifiers are: 

Label 
MainWindow 
Menu 
MenuBar 
Notepad 
PushButton 
Scrollbar 
Text 

For dxnotepad, the available name identifiers are: 

notepad The name of the application. 

textwindow View of the edit window. Each edit window can 
have one or more views into a text buffer or file. 
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Files 

In addition to the general resources listed in x(1X), the resources available 
for dXDotepad are: 

EnableBackups Specifies that the original file is saved as the backup 
file. The name of the backup file is constructed by 
prepending the orignal file name with the string 
contained within the backupNamePrefix, and 
appended with the backupNameSuffix. The default 
is On. 

BackupNamePrefix Specifies the prefix of the backup file name. 

BackupNameSuffix Specifies the suffix of the backup file name. 

Geometry Specifies the geometry (window size and location) to 
be used as the default for the dXDotepad window. 
For more information about the geometry 
specification and screen coordinate system, see 
X(1X). If Geometry is not specified, a default built­
in geometry is used. 

filter Specifies a text filter to add as an option to the Edit 
. menu. The resource value has two parts, separated 
by one or more space or tab characters: the option 
name to add to the menu and the UL TRIX command 
to execute when that option is selected. 

journalNamePrefix Specifies the prefix of the journal file name. 

journalNameSuffix Specifies the suffix of the journal file name. 

Each specification included for the translations resource in the .Xdefaults file 
modifies a key setting for the editor that dxnotepad uses. For more 
information about key and mouse specifications in the .Xdefaults file, see 
X(1X). 

-/.Xdefaults 

See Also 
X(1X), dxwm(1X), DECwindows Desktop Applications Guide 
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Name 
dxpaint - DECwindows bitmap editor 

Syntax 
dxpaint [ options ] 

Description 

The dxpaint application allows you to create and edit bitmap images (for 
example, simple sketches or pictures). These images are treated as a 
collection of pixels. By using different drawing tools, you can edit pixels to 
create lines, shapes, and text. The resulting bitmap image can then be saved 
as a file, printed, or copied to another application. 

For the bitmap image, the standard file format is Digital Document 
Interchange Format (DDIF). Therefore, you can also project these images on 
your display with the DDIF Viewer. 

The dxpaint window offers a variety of art tools and basic shapes. For 
example, you can work with a pencil, a paintbrush, a can of spray paint, or a 
paint bucket. The current tool is highlighted. To make a tool current, click 
on it. Only one tool on the tool palette can be active at a time and that tool 
remains active until you make another selection. 

Options 

-bd color 

-bg color 

-d dispname 

Specifies the color of the window's border (color 
displays only). The default is the window border 
color specified by Session Manager. 

Specifies the color of the window's background 
(color displays only). The default is the window 
background color specified by Session Manager. 

Specifies the display screen on which dxpaint 
displays its window. If the display option is not 
specified, dxpaint uses the display screen specified 
by your DISPLAY environment variable. The 
display option has the format hostname :number. 
Using two colons (::) instead of one (:) indicates 
that DECnet is to be used for transport. The default 
is :0. For more information, see X(lX). 

Commands 1-61 



dxpalnt (1 X) 

-display dispname 

-fg color 

-fnJont 

M&nus 

This option is the same as the -d option. 

Specifies the color of the window's foreground 
(color displays only). The default is the window 
foreground color specified by Session Manager. 

Specifies the font used as the output font in digital 
mode. Any fixed-width font can be used. The 
default is 6x 10. 

The dxpaint application contains the following menus: 

File 
Edit 
Options 
Font 
Customize 

File Menu 
The File menu contains the following items: 

Open... Displays a dialog box in which you specify the file 
to open. The dialog box displays the names of the 
graphics files in the current directory. To specify a 
graphics file not listed, type the file name. 

Save 

Save As.". 
Print 

Print ••• 

Quit 
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Saves the picture in the current file. If no file exists, 
dxpaint displays a dialog box that prompts for the 
file name. 

Saves the picture in a file whose name you specify. 

Prints the picture using the values previously set in 
the print dialog box. If this is the first print request, 
the Print dialog box is displayed. 

Displays the Print dialog box (which allows you to 
specify a printer, output format, and so forth) and 
prints the picture using these settings. The output 
format can be ANSI2 (sixel) or PostScript. If you 
are using an LA50 printer, you must specify an 
aspect ratio of 2:1. 

Quits the current dxpaint session and closes the 
dxpaint window. If no changes were saved, 
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dxpaint displays a Caution dialog box. 

Edit Menu 

The Edit menu contains the following menu items: 

Undo/Redo Undoes or redoes the last paint operation. 

Cut Clears the selection from the drawing window and 
copies it to the clipboard. 

Copy 

Paste 

Clear 

Invert 

Crop 

Scale ... 

Select All 

Scale Picture ... 

Options Menu 

Copies the image selected from the drawing window 
onto the clipboard. 

Pastes an image from the clipboard into the drawing 
window. 

Erases any area previously selected with the 
selection box or scissors tool. 

Creates a negative image of the selection by 
displaying it in reverse video. 

Repositions the selection in the upper left comer of 
the window and discards the rest of the painting. 

Displays a dialog box that lets you scale a selection. 
Enter a number less than 100 to shrink the selection 
or a number greater than 100 to expand the 
selection. 

Selects the entire contents of the drawing window. 

Displays a dialog box that lets you scale the entire 
picture. Enter a number less than 100 to shrink the 
picture or a number greater than 100 to expand the 
picture. 

The Options menu contains the following menu items: 

Brushes... Displays a dialog box that lets you choose the size 
and shape of the paintbrush. 

Line Width ... Displays a dialog box that lets you choose the line 
thickness for the shape to be drawn with the selected 
tool. This affects lines, arcs, ellipses, circles, 
rectangles, squares, strokes, and polygons. 
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Patterns •.. 

Edit Pattern •.• 

Opaque 

Transparent 

Grid On/Off 

Zoom On/Off 

Full View ... 
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Displays a dialog box that provides a selection of 
designs that you can use as border and fill patterns. 
The foreground, background, and "none" patterns are 
always available. Click on the button at the top left 
of the dialog box to signal a change in the border 
pattern; click on the button at the top right to signal 
a change in the fill pattern. Next, click on any of the 
patterns (including foreground, background, and 
"none") to select it as the border or fill pattern. 

Displays a dialog box that lets you modify an 
existing pattern. Before choosing this menu item, 
you must indicate whether you are customizing a 
border or a fill pattern by clicking on the appropriate 
button in the Patterns dialog box. Next, choose the 
pattern to edit. The dialog box contains a magnified 
version of the pattern you chose (16 pixels by 16 
pixels). 

Prevents background shapes from showing through 
the clear areas of patterned objects in the foreground. 
Opaque is the default. 

Allows background shapes to show through the clear 
areas of patterned objects in the foreground. 

Turns a fixed snap grid on and off. This is used in 
alignment. 

Magnifies a portion of the picture. Displays a 
magnifying frame and a Zoom window. Drag the 
frame to the portion of the picture to be magnified 
and release MB 1. The framed image appears in the 
Zoom window and is magnified eight times. To 
close the Zoom window, display the Opions menu 
and choose Zoom Off. 

Displays a dialog box that shows the entire picture 
in smaller scale. U sing this dialog box, you can 
select a portion of the picture to edit or you can crop 
the picture. 
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Font Menu 

The Font menu contains the following items: 

Family Allows you to choose from Courier, Times, and 
Helvetica fonts. 

Size Specifies the point size. Choose from 10, 12, 14, 
18, and 24 points. 

Style 

Customize Menu 

Specifies normal, italic, or bold typeface. 

The Customize menu contains the following items: 

Picture Size... Displays a dialog box that lets you change the size 
and output resolution of the picture. The maximum 
picture size is 2550 x 3300 pixels, which is 8 1/2 x 
11 inches at 300 dots per inch. The minimum 
picture size is lOx 10 pixels. You can choose a 
predefined size or select Non-Standard and supply 
the width and height of the picture in pixels, inches, 
or centimeters. You can choose a predefined 
resolution or select Non-Standard and supply the 
resolution in dots per inch. 

X Defaults 

The dxpaint application reads the .Xdefaults file during startup and uses the 
appropriate resource specification to customize the appearance or 
characteristics of its displayed dxpaint window. The format for a resource 
specification in the .Xdefaults file is: 

[name*] resource: value 

name Specifies the application name or the name string that 
restricts the resource assignment to that application or to a 
component of an application. If this argument is not 
specified, the resource assignment is globally available to all 
X applications. 

resource Specifies the resource. 

value Specifies the value that is to be assigned to the resource. 
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Files 

For more information, see X(lX). 

Because each toolkit-based application can consist of a combination of 
widgets (for example, push buttons and a scroll bar), you can form the name 
string by adding widget class and name identifiers to the string. For further 
information about adding class and name identifiers, see X(lX). 

For dxpaint, the available class identifiers are: 

paint 
main_menu_bar 
paint_ v _scroll_bar 
paint_h_scroll_ bar 

For dxpaint, the available name identifiers are: 

dxpaint 

The general resources available for dxpaint can be found in x(1X). 

Each specification included in the .Xdefaults file for the translations resource 
modifies a key setting for the editor that dxpaint uses. For more information 
about key and mouse specifications in the file, see X(1) 

-/.Xdefaults 
/usr/lib/X 11/app-defaults/DXpaint 

See Also 
X(lX), dxwm(lX), DECwindows Desktop Applications Guide 
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Name 
dxpsview - DECwindows PostScript previewer 

Syntax 
dxpsview [ options ] [file ] 

Arguments 

file 

Description 

Specifies the file to open at startup. If you omit a file 
name, you can open a file from within dxpsview. 

The dxpsview PostScript viewer displays files coded in the PostScript page 
description language. The dxpsview window consists of the following four 
areas: 

Title Bar 

Menu bar 

Work area 

Status area 

Options 

-bd color 

-bg color 

Displays the name of the window, the name of the 
file currently being viewed, and window manager 
icons that allow you to move and resize the 
dxpsview window and shrink the window to an icon. 
For more information, see dxwm( IX). 

Lists the available dxpsview menus. 

Contains the image of a page generated by the 
PostScript document (or some of that image if the 
page is larger than the work area). This window 
does not accept input focus and does not support text 
selection. 

Specifies the current page status and provides 
buttons for viewing the next or previous page. 

Specifies the color of the window's border (color 
displays only). The default is specified by means of 
the Session Manager's Customize Window dialog 
box. 

Specifies the color of the window's background 
(color displays only). The default is specified by 
means of the Session Manager's Customize Window 
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-d dispname 

-display dispname 

-geometry 

Menus 

dialog box. When a file is open, the work area has 
its own color, which cannot be customized. 

Specifies the display screen on which dxpsview 
displays its window. If the display option is not 
specified, dxpsview uses the display screen specified 
by your DISPLA Y environment variable. The 
display option has the format hostname:number. 
U sing two colons (::) instead of one (:) indicates that 
DECnet is to be used for transport. The default is 
:0. For more information, see X( IX). 

This option is the same as the -d option. 

Specifies the width, length, and location of the 
dxpsview window. If this option is not specified, 
dxpsview uses default values. The geometry option 
has the format [width][xlength][x][y]. For more 
information about the screen coordinate system, see 
X(1X). 

The dxpsview application contains the following menus: 

File 
Page 
Options 

File Menu 

The File menu contains the following items: 

Open Selected Opens a file that you selected using the pointer in 
another application window on the screen. 

Open... Displays a File Selection dialog box that lets you 
specify the file to open. To view a file in another 
directory or one that does not have the .ps extension, 
change the pattern in the File Filter text input field 
and click on the Filter button. When a file is 
opened, the title bar displays its file name. 

Revisit 
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Reopens the current file. This is useful for 
displaying modifications you have made to the 
source file. 



Exit 

Page Menu 
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Closes the dxpsview window and exits from the 
application. 

The Page menu contains the following items: 

Display number Displays the page that precedes the current page. If 
the current page is the first page, this menu item is 
disabled. 

Display .•• 

Display number 

Options Menu 

Displays a dialog box that prompts for the number 
of the page to display. 

Displays the page that follows the current page. If 
the current page is the last page, this menu item is 
disabled. 

The Options menu contains the following items: 

Sheet Selection Displays a dialog box that lets you specify how 
dxpsview displays the file image on a screen 
"sheet." 

The Sheet Sizes option lets you select the screen 
sheet size. Each PostScript file is designed for a 
particular page size; this option lets you match the 
screen sheet size to the page size in the file. If the 
screen sheet size is smaller than the file's, some of 
the file image is lost. If the screen sheet size is 
larger than the file's, white space appears around the 
file image. The choices are Letter, Legal, Ledger, 
Executive, A3, A4, A5, B4, and B5. The default is 
Letter. 

The sheet can be at one of four angles, in portrait or 
landscape orientation. Click on the button next to 
the layout you prefer. The default is upright (0 
degrees), in portrait layout. 

The scale factor specifies how much to shrink or 
magnify the images in the file, in comparison to 
their sizes when printed on paper. The scale factor 
range is from .1 to 4.0; the default value is 1.0 
(screen images are the same size as printer images). 
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When you change the scale factor from the default 
value, the new scale factor appears in the status area. 

Use Comments Turns comment mode on or off. In comment mode, 
dxpsview attempts to interpret comments in the file 
as hints that allow moving from page to page more 
quickly. By default, comment mode is on. If you 
have trouble viewing a file, you may be able to 
correct the problem by turning off comment mode. 

Use Bitmap Widths Specifies whether to use the bitmap widths or 
scalable widths of the predefined fonts. Using 
bitmap widths, characters are spaced more evenly 
and legibly, but the right edge of paragraphs is 
jagged. U sing scalable widths, the right edge lines 
up but character spacing is uneven. Scalable widths 
help to show font placement when you are viewing a 
document for form rather than content. A change in 
this setting applies to the next file that you open; to 
apply the change to the current file, choose Revisit 
from the File menu. This option is turned off by 
default. 

Use Fake Trays Allows files containing tray size directives to be 
displayed. Some PostScript files for the LPS40 
include tray size directives. Tray size directives are 
PostScript programming language instructions that 
tell the printer which tray size to use. For example, a 
file might contain tray size directives that instruct 
the printer to switch from the letter tray (8 1/2 x 11) 
to the ledger tray (11 x 17) while printing the file. 
The viewer does not, however, permit the addition of 
tray size directives to PostScript files in this way. 

If you try to display a file that contains PostScript 
tray size directives, dxpsview displays an error 
message. To display the file, acknowledge the error, 
choose the Use Fake Trays menu item, and redisplay 
the file by choosing the Revisit menu item from the 
File menu. By default, this option. is turned off. 

Watch Progress The Watch Progress menu item lets you specify how 
dxpsview draws images onto the screen. Usually, 
dxpsview prepares and stores an entire page in its 
cache before drawing it. With the Watch Progress 
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option on, dxpsview displays images immediately as 
it prepares them. This option is turned off by 
default. 

The command box of the dxpsview window contains the following labels 
and buttons: 

Page 

Next Page 

Previous Page 

Cancel 

Scale Factor 

X Defaults 

Specifies the number of the page currently being 
displayed. In most cases, the label specifies the total 
number of pages that can be displayed in the file. 

Displays the next page. If the current page is the 
last page, this command is disabled. 

Displays the previous page. If the current page is 
the first page, this command is disabled. 

Cancels a display operation. The Cancel command 
is enabled only while dxpsview is in the process of 
displaying a file or page. When dxpsview stops 
displaying the file, it leaves the screen sheet with 
whatever was completed at the time you cancelled 
the operation. 

Displays the current scale factor, in the format nnX, 
when the scale factor is other than 1.0. 

The dxpsview application reads the .Xdefaults file during startup and uses 
the appropriate resource specification to customize the appearance or 
characteristics of its displayed dxpsview window. The format for a resource 
specification in the .Xdefaults file is: 

[name*] resource: value 

name Specifies the application name or the name string that 
restricts the resource assignment to that application or to a 
component of an application. If this argument is not 
specified, the resource assignment is globally available to all 
X applications. 

resource Specifies the resource. 

value Specifies the value that is to be assigned to the resource. 
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For more information, see X(1X). 

Because each toolkit-based application can consist of a combination of 
widgets (for example, push buttons and a scroll bar), you can form the name 
string by adding widget class and name identifiers to the string. For further 
information about adding class and name identifiers, see X( IX). 

For dxpsview, the available class identifiers are: 

DPSViewer 
Label 
MainWindow 
Menu 
Pulldown 
PushButton 
Scroll 
Scrollw 
Separator 
Window 

The class DPSViewer must be specified in the .Xdefaults file when the 
resource applies to dxpsview only. The class DPSViewer must be the first 
element in the specification. 

For dxpsview, the available name identifiers are: 

commandBar Applies the resource to the command bar located at the 
bottom of the dxpsview window. The named items on the 
command bar are odometer, next, prev, abortBtn, and 
scale. 

scrollw Applies the resource to all dxpsview scroll bars. 

vbar 

hbar 

menuBar 

file 

page 
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Applies the resource to the vertical scroll bar. To specify a 
resource for either the up or down stepping arrows, you 
can add the name ScrollButtonl or ScrollButton2. 

Applies the resource to the horizontal scroll bar. To 
specify a resource for either the left or right stepping 
arrows, you can add the name ScrollButtonl or 
ScrollButton2. 

Applies the resource to the menu bar. 

Applies the resource to the File menu. To specify a 
resource for one of the items displayed in the file menu, 
you can specify openSel, openDialog, revisit, or quit. 

Applies the resource to the Page menu. To specify a 



Files 

options 

Help 

dxpsview ( 1 X) 

resource for one of the items displayed in the file menu, 
you can specify displayPrev, displayChoose, or 
displayNext. 

Applies the resource to the Options menu. To specify a 
resource for one of the items displayed in the File menu, 
you can specify trays, comments, bwidths, faketrays, or 
window Draw Mode. 

Applies the resource to the Help menu. To specify a 
resource for one of the items on the Help menu, you can 
specify Help or About. 

In addition to the general resources listed in X(1X), the resources available 
for dxpsview are: 

pixmapCacheSize Specifies the number of pages that dxpsview 
stores in its cache. If the value is greater than 
0, dxpsview can display previously viewed 
pages more quickly. However, the greater the 
number, the more memory used in the server. 
The default is O. 

fileNameSuffix 

fileNamePrefix 

..... /.Xdefaults 

Specifies the file name extension used by the 
Open ... menu item in the File menu. The 
default is ps. 

Specifies the directory used by the Open ... 
menu item in the File menu when searching 
for a file. The default is the directory from 
which the previewer was invoked. 

/usr/lib/X 11/app-defaults/DPS Viewer 

See Also 
X(IX), dxwm(IX), DECwindows Desktop Applications Guide 
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Name 
dxpuzzle - DECwindows interface to a puzzle game 

Syntax 
dxpuzzle [ options] 

Description 

The dxpuzzle command displays a window that contains a puzzle. The 
puzzle is a video version of a number puzzle with slidable squares. The goal 
is to arrange the squares in ascending order in the fewest possible moves. To 
move a square, click on it. 

Options 

-bd color 

-bg color 

-d dispname 

-display dispname 

-fg color 

-fn/ont 
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Specifies the color of the window's border (color 
displays only). The default is specified by means of 
the Session Manager's Customize Window dialog 
box. 

Specifies the color of the window's background 
(color displays only). The default is specified by 
means of the Session Manager's Customize Window 
dialog box. 

Specifies the display screen on which dxpuzzle 
displays its window. If the display option is not 
specified, dxpuzzle uses the display screen specified 
by your DISPLA Y environment variable. The 
display option has the format hostname :number. 
Using two colons (::) instead of one (:) indicates that 
DECnet is to be used for transport. The default is 
:0. For more information, see X( IX). 

This option is the same as the -d option. 

Specifies the color of the text (color displays only). 
The default is specified by means of the Session 
Manager's Customize Window dialog box. 

Specifies the font for all parts of the puzzle other 
than the numbers. Use the defaults file to change the 
font of numbers. The default is menuI2. 
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Specifies the width, length, and location of the 
dxpuzzle window. If the geometry option is not 
specified, dxpuzzle uses default values. The 
geometry option has the format 
[width][xlength] [x] fy]. For more information about 
the screen coordinate system, see X(lX) . 

The dxpuzzle application contains the following menus: 

File 
Customize 
Help 
Pop-Up 

File Menu 

The File menu contains the following items: 

New Game Specifies that dxpuzzle scramble the squares 
and start a new game. 

Quit Closes the dxpuzzle window. 

Customize Menu 

The Customize menu contains the following items: 

Settings... Displays the Settings dialog box that lets you 
specify the number of squares displayed in the 
puzzle. 

Save Current Settings 

Use System Defaults 

Help Menu 

Saves the number of squares and the puzzle's 
size and position. These values will be used 
the next time you run the puzzle. 

Restores the use of system default values for 
number of squares and puzzle size and 
position. 

The Help menu contains the following items: 

Overview Displays an overview of the dxpuzzle 
command 

About Provides specific information about dxpuzzle. 
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Pop-up Menu 
The dxpuzzle window has one pop-up menu. To display this pop-up menu, 
place the pointer at any position within the dxclock window and click MB2 
(the middle mouse button, unless you have redefined it). This menu contains 
the following items: 

New Game 
Settings ... 
Quit 

X Defaults 

The dxpuzzle application reads the .Xdefaults file during startup and uses the 
appropriate resource specification to customize the appearance dxpuzzle 
window. The format for a resource specification in the .Xdefaults file is: 

[name*] resource: value 

name Specifies the application name or the name string that 
restricts the resource assignment to that application or to a 
component of an application. If this argument is not 
specified, the resource assignment is globally available to all 
X applications. 

resource Specifies the resource. 

value Specifies the value that is to be assigned to the resource. 

Because each toolkit-based application can consist of a combination of 
widgets (for example, push buttons and a scroll bar), you can form the name 
string by adding widget class and name identifiers to the string. For further 
information about adding class and name identifiers, see X( IX). 

For dxpuzzle, the available class identifiers are: 

Puzzle 
WorkArea 

For dxpuzzle, the available name identifiers are: 

Puzzle*workarea Changes such as font and colors for the work area 
only. 

game_level Initial number of squares in the puzzle. 
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The general resources listed in X(1X) apply to dxpuzzle. 

-/.Xdefaults 
/usr/lib/Xll/app-defaults/DXpuzzle 

See Also 

dxpuzzle (1 X) 

X(1X), dxwm(1X), DECwindows Desktop Applications Guide 
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Name 
dxsession, Xprompter - DECwindows session manager and login window 

Syntax 
dxsession 

Description 
The dxsession program provides a window-oriented interface that gives you 
access to a workstation. In addition, you can use dxsession to invoke high­
level applications and customize the workstation environment. 

By default, dxsession is automatically executed from the /etc/ttys file. A 
sample command line in the /etc/ttys file for a color workstation is as 
follows: 

:0 "/usr/bin/login -P /usr/bin/Xprompter -c 
/usr/bin/dxsession" none on secure window= 
"/usr/bin/Xqdsg -fd 75 -bp #000080 c 70" 

For a monochrome workstation the command line is as follows: 
:0 "/usr/bin/login -P /usr/bin/Xprompter -C 
/usr/bin/dxsession" none on secure window= 
"/usr/bin/Xqvsm -fd 75 c 70" 

In these command lines, login has two flags. The first flag, -P, specifies the 
prompting program (in this case, Xprompter). The Xprompter command 
displays the dialog box through which you log into a session. The second 
flag, -C, specifies the command that login runs through your shell (in this 
case, it runs dxsession). The last command starts the X Server. 

A DECwindows session begins when you log into the workstation through 
the Start Session dialog box. Once you complete logging in, dxsession reads 
your .Xdefaults file and incorporates any values that it contains into the X 
Server. Next, dxsession sets the DISPLAY variable to :0 and starts the 
window manager. The default window manager is dxwm. (You can use 
another window manager by specifying it in the .Xdefaults file or by entering 
it in the Customize Window dialog box.) 

The session manager window appears, and dxsession starts up the 
applications contained in the AutoStartup list. If you have an .XIIStartup file 
in your home directory, dxsession reads that as well. The .XI1Startup file is 
a shell script that you can use to execute commands at startup. It is usually 
unnecessary, unless you execute commands that use environment variables, 
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because you can use the AutoStartup list to specify which applications should 
start automatically. 

Use the Customize menu to tailor dxsession. Whenever you save the 
attributes you have specified by means of the Customize dialog boxes, 
dxsession writes resource specifications into your .Xdefaults file (from which 
it again reads them at subsequent startups). 

Start Session Dialog Box 
The start session dialog box gives you initial access to the workstation by 
displaying text input fields that accept a login name and a password. The 
Login field has input focus when the dialog box appears. After entering your 
login name, press the Return key to move to the password field. You can also 
set the insertion point at a text field by positioning the pointer there and 
clicking MB 1 (the left button, unless you have redefined it). 

If your login name is longer than its text field, the text in the field scrolls one 
character to the left each time you type a new character. Password characters 
are not echoed on the screen. To confirm your login name and password, 
click on the OK button or press the Return key after typing your password. 
To cancel the operation, click on the Cancel button. 

After the login name and password are confirmed, dxsession starts the 
window manager and displays the session manager window. 

Session Manager Window 
The session manager window consists of the following areas: 

Title Bar Displays window manager icons that let you move, 
and resize the· session manager window and shrink 
the window to an icon. For more information, see 
dxwm(1X). 

Menu Bar 

Message Region 

Lists the available dxsession menus (such as 
Applications and Customize). 

Displays system status messages. By default, the 
message region is a scrollable text region that 
displays seven lines of text. If system status 
messages are received while the session manager 
window is in icon form, the appearance of the icon 
changes. 
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Menus 

The session manager window contains the following menus: 

Session 
Applications 
Customize 
Print Screen 

Session Menu 
The Session menu contains the following items: 

Pause 

Quit 

Applications Menu 

Places a blank screen over the workstation screen 
and displays the Continue Session dialog box, which 
prompts for the password of the person whose 
session was paused. When you enter the correct 
password, dxsession removes the blank screen and 
resumes the session. 

Ends the current session and exits from all 
applications. 

The Applications menu contains a list of applications that you can start. By 
default it includes all of the standard DECwindows applications (Notepad, 
Mail, Cardfiler, DECterm, User Executive, and so forth). Choose one of the 
applications to start it up. You can add applications as items on the menu or 
remove those currently listed by choosing the Applications Menu item from 
the Customize menu. 

Customize 
The Customize menu contains the following items: 

Application Definitions... Displays a dialog box that lets you provide or 
change application definitions. An application 
definition consists of the name to use in Session 
Manager menus and the associated command 
that is executed when dxsession starts the 
application. Applications must be defined 
before you can add them to the Applications 
menu or Autostartup list. 

Applications Menu... Displays a dialog box that lets you specify the 
applications that appear on the Applications 
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AutoStartup ••. 

Keyboard ... 

Language ... 

Pointer .•. 

Print Screen ... 

dxsession (1X) 

menu. You must define an application by means 
of the Customize Applications Definitions menu 
before you add it to to the Applications menu. 

Displays a dialog box that lets you specify the 
applications that dxsession automatically starts 
each time a session starts. You must define an 
application by means of the Customize 
Applications Definitions menu before you add it 
to to the Applications menu. 

Displays a dialog box that lets you specify 
characteristics of your keyboard (such as bell 
and key click volume). 

Displays a dialog box that lets you specify the 
language in which you prefer to work. 

Displays a dialog box that lets you specify 
characteristics of your pointer (such as its shape 
and color). 

Displays the Customize Print Screen dialog 
box, which lets you customize the following 
attributes: 

Output Format Selects the image's output format. 
Output can be prepared for 
printing on a PostScript, sixel, or 
DDIF printer. A bitmap can also 
be placed directly in a file. The 
options are PostScript, standard 
sixel file format, or DDIF image 
format for bitmap files. The 
default format is PostScript. 

Output Color Specifies that the image is black 
and white, that black and white 
should be combined to produce 
gray shades, or that the image 
should be prepared for a color 
printer. The default is black and 
white. 

Aspect ratio Specifies how many printer pixels 
represent each screen pixel. Some 
devices have square pixels and 
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Security ••• 
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some have rectangular pixels. The 
aspect ratio 2 to 1 uses twice as 
many device pixels as screen 
pixels in one direction to make the 
image shape come out correctly 
on devices with rectangular pixels. 
The default is 1 to 1. 

Ribbon or Toner Saver 
Specifies that ribbon or toner 
should be saved by reversing the 
image. When dxsession is 
printing color or gray shades, this 
option is ignored. The default is a 
positive image. 

Rotate Picture to Fit Paper 
Specifies that a picture's 
orientation is automatically rotated 
or its size reduced so that it fits on 
a single sheet of paper. 

Prompt for File Name 
Specifies that each Capture Screen 
operation displays a dialog box 
asking for the name of the output 
file. When the toggle is on, the 
dialog box appears; when the 
toggle is off, the output file is the 
one whose name appears in the 
Output File Name text field. 

Output File Name 
Lets you specify the name of the 
Capture Screen output file. The 
default destination for captured 
screen images is printscreen.ps. If 
the output file name starts with a 
vertical bar (I), the destination is 
interpreted as a command to 
which the output is piped (for 
example, Ilpr). 

Displays a dialog box that lets you specify the 
hosts that can display applications on this 



Session Manager .•. 

Window ..• 

Use Last Saved Settings 

Use System Defaults 

Save Current Settings 

Print Screen Menu 
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workstation. 

Displays a dialog box that lets you customize 
attributes of dxsession. These include its start­
up state (as an icon or opened window), the text 
that appears when your workstation is paused, 
and the message region's size and header. 

Displays a dialog box that lets you specify 
screen and window characteristics. These 
include colors, size of your icons, and on some 
systems, the screen background pattern. In 
addition, if you want to use a window manager 
other than the default DECwindows one, you 
can specify it here. 

Restores the settings you last saved. 

Restores the system default settings. 

Saves the current settings. 

The Print Screen menu lets you print screen images or capture them to a file. 
You can print or capture the entire screen or a portion of it. 

The Print menu consists of the following items: 

Print Entire Screen 

Print Portion of Screen 

Takes a snapshot of the screen, displays 
the Print Options dialog box so that you 
can specify print attributes, and sends 
the snapshot to the printer. 

Lets you delineate the portion to print, 
takes a snapshot of the area you 
delineated, displays the Print Options 
dialog box so that you can specify print 
attributes, and sends the snapshot to the 
printer. 

To delineate the portion to save, use the 
following technique: Position the pointer 
at one comer of the area you want to 
mark off. Press and hold MB 1 to display 
a box outline, and then adjust the size 
and location of the box outline by 
dragging the pointer. Release MB 1. 
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Capture Entire Screen 

Capture Portion Of Screen 

X Defaults 

Saves an image of the entire screen in a 
file. The file name is specified in the 
Customize Print Screen dialog box; if 
the toggle button for Prompt for File 
Name is on in that dialog box, you are 
prompted to confirm or specify the file 
name. 

Saves a portion of the screen in a file. 
The file name is specified in the 
Customize Print Screen dialog box; if 
the toggle button for Prompt for File 
Name is on in that dialog box, you are 
prompted to confirm or specify the file 
name. 

To delineate the portion to save, use the 
following technique: Position the pointer 
at one comer of the area you want to 
mark off. Press and hold MB 1 to display 
a box outline, and then adjust the size 
and location of the box outline by 
dragging the pointer. Release MB 1. 

The dxsession application reads the .Xdefaults file during startup and uses 
the appropriate resource specification to customize the appearance or 
characteristics of its displayed dxsession window. The format for a resource 
specification in the .Xdefaults file is: 

[name*] resource: value 

name Specifies the application name or the name string that 
restricts the resource assignment to that application or to a 
component of an application. If this argument is not 
specified, the resource assignment is globally available to all 
X applications. 

resource Specifies the resource. 

value Specifies the value that is to be assigned to the resource. 

For more information, see X(1X). 
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Because each toolkit-based application can consist of a combination of 
widgets (for example, push buttons and a scroll bar), you can form the name 
string by adding widget class and name identifiers to the string. For further 
information about adding class and name identifiers, see X(1X). 

Note that the first name for lines that apply only to the session manager 
should be labeled "sm". 

For dxsession, the available classes are: 

AttachedDialogBox 
Dialog 
Label 
MainWindow 
Menu 
Menubar 
Message 
Pulldown 
Pushbutton 
SText 
Toggle 

For dxsession, the available names are: 

ConfirmFilename 
ConfirmPrint 
CreatePulldown 
CusotmizeAutoStart 
CustomizeAppDef 
CustomizeAppMenu 
CustomizeKeyboard 
CustomizePrinter 
CustomizePulldown 
Customize Security 
CustomizeSession 
Customize Window 
MainWindow 
Menubar 
Messages 
PrintPulldown 
SessionPulldown 
SETLANGUAGE_BOX 
WorkAreaDialog 
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Files 

In addition to the general resources listed in X(1X), and those that the 
Customize dialog boxes specify, dxsession uses the following resources: 

terminalEmulatorName Specifies the name of the terminal emulator to run 

create vue 

create terminal 

rootPasswd 

pointer_shape 

-/.login 
-I.cshrc 
-I.X 11 Startup 
-/.Xdefaults 

at dxsession startup. The default is dxterm. 

Specifies the number of User Executive windows 
to create at startup. The default is O. 

Specifies the number of terminal emulator 
windows to create at startup. The default is 1. 

Specifies whether the root password can be used 
to resume a paused session. True means that the 
root password or the user's password is accepted; 
false means that only the user's password is 
accepted. The default is False. 

Specifies the design of the pointer character. 
DECwindows pointers are specified by negative 
numbers; choose the pointer by using the 
Customize Pointer dialog box. MIT pointers can 
be specified by positive numbers that correspond 
to values in lusr/include/Xl1/cursorfont.h. 

lusr/lib/Xl1/app-defaults/SessionManager 
lusr/lib/X ll/app-defaults/XSessionManager 
lusr/lib/Xl1/getcons 

See Also 
X(1X), dxwm(1X), init (8), ttys (5), DECwindows User's Guide 
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Name 
dxterm - DECwindows terminal emulator 

Syntax 
dxterm [ options] 

Description 
The dxterm command displays a window that provides Digital VT320 
terminal emulation and a standard terminal type for programs not aware of 
the X Window System directly. The terminal emulator also supports the 
ReGIS and sixel graphics protocols. 

Options 

-customization string Specifies a value for a dxterm resource that 
overrides a default setting. The string has the form 
resource: value. You can specify this option multiple 
times to change multiple resources. See X 
DEFAULTS for a list of resources that can be 
changed. You can specify both dxterm and shell 
resources as *resource. 

-d dispname Specifies the display screen on which dxterm 
displays its window. If the display option is not 
specified, dxterm uses the display screen specified 
by your DISPLA Y environment variable. The 
display option has the format hostname :number. 
U sing two colons (::) instead of one (:) indicates that 
DECnet is to be used for transport. The default is 
:0. For more information, see X( IX). 

-display dispname Is the same as the -d option. 

-e command [ options] Specifies that the named command, and any of its 
specified options, be executed in the dxterm window 
when the window is first created. This option must 
appear last on the dxterm command line. 

-geometry Specifies the width, length, and location of the 
dxterm window, in pixels. If this option is not 
specified, dxterm positions the window at a default 
location and sizes the window according to the 
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-Is 

-setup file 

-size CxR 

-xrm string 

Menus 

number of rows and columns and the size of the 
characters. To specify the window size in rows and 
columns, use the -size option, which does not require 
knowledge of character size. The geometry option 
has the format [width][xlength][x][y]. For more 
information about the screen coordinate system, see 
X(1X). 

Specifies that dxterm create a login shell rather than 
a subshell. 

Specifies the setup file or files that provide 
parameters that control the terminal's initial settings. 
This must be a file saved by the Customize/Save 
function in dxterm. The default is 
-/default.DECtenn. Specify -setup "" to prevent 
default.DECtenn from being read. 

Specifies the size of the dxtenn window in columns 
(C) and rows (R). 

Is the same as the -customization option. 

The menu bar contains the following items: 

Commands 
Edit 
Customize 

Commands Menu 
The Commands menu contains the following items: 

Clear Lines Off Top Erases data recorded by dxterm from the top 
of the scrolling area. 

Clear display 

Resize window 

Clear Comm 

Reset Terminal 
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Clears the display and positions the cursor at 
the first column and first line of the display. 

Changes the size of the window to match the 
display so that all characters in the display are 
visible. 

Clears the communication buffers. 

Resets the emulator to the original settings; for 
example, sets the keyboard action mode to 



Clear Communications 

Quit 

Edit Menu 

dxterm(1X) 

unlocked and the keypad mode to numeric. 

Clears the communication buffers. 

Shuts down the terminal emulator application 
(removes all its windows, stops the process 
running the emulator, and ends any 
applications). 

The Edit menu contains the following items: 

Copy Copies the text selected from the dxterm 
window onto the clipboard. 

Paste Pastes text selected from the clipboard into the 
dxterm window, as if it had been typed. 

Select All Selects all displayed text. 

Customize Menu 
The dxterm setup features are grouped into a number of related categories. 
The Customize menu lets you access the dialog box for each of these 
categories (these correspond to VT320 Set-Up screens). 

The Customize menu contains the following items: 

Window... Displays the Window Customize dialog box, 
which contains controls that affect the window 
features. 

Display ••• 

General ••. 

Keyboard ••• 

7·Bit NRCS Selection .•• 

Graphics ••• 

Displays the Display Customize dialog box, 
which contains controls that affect the format 
of the user's current window. 

Displays the General Customize dialog box, 
which contains controls for commonly 
changed Customize features. 

Displays the Keyboard Customize dialog box, 
which contains controls for keyboard operating 
features. 

Allows you to specify a 7-bit National 
Replacement Character Set (NRCS). 

Displays the Graphics Customize dialog box 
that contains controls for ReGIS and sixel 
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graphics. 

Use Last Saved Settings Restores the setup configuration from the most 
recently read or written saved setup file 
(corresponds to NVR recall on a VT320 
terminal). 

Use System Defaults Reinitializes the terminal emulator with the 
system default characteristics defined by your 
system. 

Use Saved Settings From... Opens a different saved setup configuration. 
The standard DECwindows file selection 
dialog box appears, showing a list of saved 
setup files in the current directory. Selecting 
one of these files and clicking on OK (or 
double-clicking on the file) reinitializes the 
terminal emulator with the configuration stored 
in that file. 

Save Current Settings Saves the current setting. If you do not 
specify a file, dxterm writes to the file 
..... Jdefault.DECterm. 

Save Current Settings As... Saves the current settings in the file you 
specify. 

Customize Dialog Boxes 
The Customize dialog boxes represent the state of the terminal. At 
application startup, the previously saved state of most terminal features is 
read from a saved set-up file (which corresponds to VT320 NVR); these 
feature settings remain constant until you explicitly change them. You can 
change terminal operating features directly by means of the Customize dialog 
boxes. You can also change some of these features indirectly by means of 
control functions from the host. 

There are a few terminal features whose state is not stored in a saved setup 
file. These features are restored to their factory default values at application 
startup, or when you reset the terminal (with Reset Terminal or DECSTR). 

Window Customize Dialog Box 
The Window Customize dialog box lets you change the following display 
attributes: 

Auto Resize Terminal Changes the terminal size to match the 
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Terminal Driver Resize 

Big Font 

Little Font 
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window size automatically whenever the 
window size changes. 

Changes the window size to match the 
terminal size automatically whenever the 
terminal size changes. 

Changes the terminal size to match the size 
known to the terminal driver whenever the 
size changes in the terminal driver, and 
vice versa. 

Displays an 18-point font. 

Displays a 14-point font. 

Normal Font (80 Columns) Sets a font to a column width of 80 
characters. 

Condensed Font (132 Columns) Sets a font to a column width of 132 
characters. 

Normal/80, Condensed/132 

Window Title 

Icon Name 

Terminal Size 

Adjusts the font to match the width of the 
terminal automatically. 

Changes the title displayed in the title bar. 

Changes the title displayed in the icon box. 

Sets the number of rows and columns that 
are displayed. You can select 24, 48, or 
72 rows and 80 or 132 columns, or enter a 
custom size in the numeric entry fields. 

Display Customize Dialog Box 
The Display Customize dialog box lets you change the following display 
attributes: 

Record Lines Off Top 

Vertical Scroll Bar 

Horizontal Scroll Bar 

Vertical Cursor Coupling 

Saves lines that are scrolled off the top of 
the display. When you choose Record 
Lines Off Top, a filled-in button appears to 
the left of the menu selection. 

Displays a vertical scroll bar along the 
right side of the dxterm window. 

Displays a horizontal scroll bar along the 
bottom of the dxterm window. 

Specifies that the window scrolls vertically 
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Horizontal Cursor Coupling 

Auto Wrap 

Display Cursor 

Cursor Blink 

Batch Scroll nnn Lines 

Record nnn Lines Off Top 

so that the cursor is visible. 

Specifies that the window scrolls 
horizontally so that the cursor is visible. 

Specifies that when the cursor reaches the 
right margin, new characters are displayed 
on the next line. If you do not 
automatically wrap text, when the cursor 
reaches the right margin each new 
character deletes the previous character. 

Specifies whether the cursor is displayed. 
The default is to display the cursor. 

Specifies whether the cursor blinks. The 
default is to have the cursor blink. 

Specifies how many lines scroll at the 
same time. Increasing the Batch Scroll 
count improves performance but makes it 
harder to read text while it is scrollirig. 

Specifies how many lines to save when 
they scroll off the top of the display (when 
the Record Lines Off Top item is enabled). 

Dark Text, Light Background Sets dark text on a light background 
display. 

Light Text, Dark Background Sets light text on a dark background 
display. 

No Status Display 

Host Status Display 

Block Cursor 

Underline Cursor 
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Suppresses the status line at the bottom of 
the window. 

Specifies that a host-writable status line 
appears at the bottom of the window. 

Specifies that the text cursor is a block that 
covers the character cell. 

Specifies that the text cursor is an 
underline at the bottom of the character 
cell. 
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General Customize Dialog Box 
The General Customize dialog box lets you change the following general 
attributes: 

Newline 

Lock UDKs 

Lock User Features 

Normal Cursor Keys 

Appl Cursor Keys 

TerminalID 

Turns on new line mode (NLM), which 
causes the Return key to send a line feed 
as well as a carriage return. A line feed 
character moves the cursor to the start of 
the line as well as advancing it to the next 
line. 

Locks the user-defined keys so that the 
host system cannot change these 
definitions. 

Stops the host from changing your 
customized settings for the Auto Repeat 
key and the Foreground and Background 
display. 

Specifies that the arrow keys are set to the 
characters labeled on the keycaps. The 
keys are not mapped to any other 
functions. 

Specifies that the arrow keys are. mapped 
to application-specific functions. 

Specifies the device attributes response 
(TerminaIID). The device attributes 
response lets the host system know specific 
operating attributes of the terminal. The 
Terminal ID can be one of the following: 

VT100 
VT101 
VT102 
VT125 
VT220 
VT240 
VT320 
VT 330 
VT340 
DECterm ID 

The default is DECterm ID. 
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Numeric Keypad Specifies that the numeric keypad is set to 
the characters labeled on the keycaps. 

Application Keypad Specifies that the application keypad is set 
to function as user-defined keys. 

UPSS DEC Supplemental Specifies that dxterm use the DEC 
Multinational Character Set. To use this 
character set, set the Character Set mode 
menu item to 8-bit Characters. The default 
is the DEC Multinational Character Set. 

UPSS ISO Latin-1 Specifies that dxterm use the International 
Standards Organization (ISO) Character 
Set. To use this character set, set the 
Character Set mode menu item to 8-bit 
Characters. 

8-bit Multinational Characters Specifies the character set mode to be 8 
bits for use with the DEC Supplemental or 
ISO Latin-l Character Set. The default is 
8-bit character mode. 

7-bit NRCS Characters Specifies the character set mode to be 7 
bits for use with the National Replacement 
Character Sets. The default is 8-bit 
character mode. 

VT300 Mode, 8-bit Controls 

VT300 Mode, 7-bit Controls 

VT100 Mode 

VT52 Mode 
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Specifies that the terminal operates in 
VT300 mode and transmits 8-bit control 
characters. 

Specifies that the terminal operates in 
VT300 mode and transmits 7 -bit control 
characters. 

Specifies that the terminal operates in 
VT100 mode, using 7-bit characters for 
both input and output. 

Specifies that the terminal operates in 
VT52 mode, using 7 -bit characters for both 
input and output. 
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Keyboard Customize Dialog Box 
The Keyboard Customize dialog box lets you change the following display 
attributes: 

Warning bell Specifies whether the warning bell sounds 
when dxterm receives a BEL character 
(ASCII 7). The default is that the bell 
sounds. 

Margin Bell 

Auto Repeat 

Ctrl-Q, Ctrl-S = Hold 

<X] Delete 

<X] Backspace 

Comma Key Sends" 

Comma Key Sends ,< 

Specifies whether the warning bell sounds 
when the cursor reaches the right margin. 
The default is that the bell does not sound. 

Specifies whether a character repeats or 
does not repeat when you hold the key 
down. If you set the Lock User Feature 
menu item, the host system cannot change 
this setting. 

Specifies that the Ctrl-S and Ctrl-Q keys 
freeze and unfreeze the display. If this is 
not specified, the Ctrl-S and Ctrl-Q keys 
are transmitted to the host as data 
characters. 

Specifies that the back arrow key sends a 
delete (ASCII 127) character. Depending 
on your terminal settings, this usually 
deletes the previous character. The default 
back arrow operation sends a delete 
character. 

Specifies that the back arrow key sends a 
backspace (ASCII 8, Ctrl/H). The effect of 
this character depends on your terminal 
settings. The default back arrow operation 
sends a delete character. 

Specifies that a comma is displayed when 
you press the Shift key and comma key on 
a keyboard using the North American or 
Dutch keyboard dialect. This is the 
default. 

Specifies that a comma is displayed when 
you press the Shift key and comma key, 
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Tilde Key Sends '-

and that a left angle bracket «) is 
displayed when you press just the comma 
key on a keyboard using the North 
American or Dutch keyboard dialect. The 
default is to display a comma. 

Specifies that a left single quotation mark 
(') is displayed when you press the',.., key 
and that a tilde (,..,) is displayed when you 
press the Shift key and ',.., key on a 
keyboard using the North American or 
Dutch keyboard dialect. This is the 
default. 

Tilde Key Sends ESC Specifies that the ',.., key functions as an 
escape character (ESC) on a keyboard 
using the North American or Dutch 
keyboard dialect. The default is to display 
the characters as labeled on the keyboard. 

Angle Brackets Key Sends «» Specifies that a left angle bracket «) is 
displayed when you press the angle bracket 
key, and that a right angle bracket (» is 
displayed when you press the Shift key 
and angle bracket key. This is the default. 

Angle Brackets Key Sends '- Specifies that a left single quotation mark 
(') is displayed when you press the angle 
brackets key and that a tilde (,..,) is 
displayed when you press the Shift key 
and angle brackets key. The default is to 
display the characters as labeled on the 
keyboard. 

7-bit Nrcs Selection Dialog Box 
The 7 -bit NRCS Selection dialog box lets you select a National Replacement 
Character Set (NRCS) for use when the terminal is in 7 -bit mode. This 
selection affects output to the terminal, but not keyboard input. To select the 
keyboard dialect, which does affect input, use the Keyboard dialog box from 
the Session Manager's Customize menu. For example, to use the Spanish 
NRCS, select the keyboard in the Session Manager and also select the 
Spanish NRCS in DECterm. 
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To select a character set, click MBI on the desired entry. The choices are: 

North American 
Flemish 
Canadian (French) 
British 
Danish 
Finnish 
Austrian/German 
Dutch 
Italian 
Swiss (French) 
Swiss (German) 
Swedish 
Norwegian 
Belgian/French 
Spanish 
Portugese 

The default character set is North American. The Dutch NRCS is no longer 
supported; selecting Dutch is equivalent to selecting North American. 

Graphics Dialog Box 

Share Color Map Entries Controls whether dxterm uses shared, 
read-only colors for graphics. The default 
is Off, but the option is forced to On if the 
hardware color map is read-only. 

Enable Backing Store Specifies whether dxterm creates a pixmap 
to allow graphics to be redrawn when the 
window is exposed. The default is On. 

Report Macrograph Contents Enables the ReGIS macrograph report 
command. The default is Off. 

NN Bit Planes Controls the number of bit planes used for 
graphics. VT240 emulation requires 2 
planes; VT340 emulation requires 4 
planes. On systems with fewer than 8 
hardware planes, the default is 2 planes; on 
systems with 8 or more hardware planes, 
the default is 4 planes. 
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x Defaults 
The dxterm application reads the .Xdefaults file during startup and uses the 
appropriate resource specification to customize the appearance or 
characteristics of its displayed dxterm window. The format for a resource 
specification in the .Xdefaults file is: 

[name.]resource: value 

name Specifies the application name or the name string that 
restricts the resource assignment to that application or to a 
component of an application. If this argument is not 
specified, the resource assignment is globally available to all 
X applications. 

resource Specifies the X resource. 

value Specifies the value that is to be assigned to the resource. 

In most cases, the period (.) delimiter should be replaced by an asterisk (*). 
For more information, see X(1X). 

Because each toolkit-based application can consist of a combination of 
widgets (for example, push buttons and a scroll bar), you can form the name 
string by adding widget class and name identifiers to the string. 

For dxterm, the application class is DXterm and the application name is the 
name that was specified on the command line (usually dxterm). 

For dxterm, the available name identifier is terminal. This name identifier 
specifies the work area of the dxterm window. 

In addition to the general resources listed in X(1X), the resources available 
for the dxterm work area are: 

adjustFontSizes 

allowShellResize 

angleBracketsKey 
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Specifies that dxterm selects the normal or 
condensed font based on the number of 
columns selected. The default is On. 

If On, the program can change the size of the 
dxterm window. If Off, you can specify a 
fixed size with the geometry specification. 
However, DECterm always turns on this 
resource even if you have turned it off, 
because DECterm resizes its window 
according to the font, the number of rows, 
and the number of columns. 

Specifies the mapping of the angle brackets 



applicationKeypadMode 

autoRepeatEnable 

autoResizeTerminal 

auto Resize Window 

auto WrapEnable 

backArrowKey 

backingStoreEnable 

batchScrollCount 

bigFontSetName 

bitPlanes 

dxterm(1X) 

«» key. Zero maps the key to 
AngleBrackets (0); 1 maps it to 
OpenQuoteTilde (1). The default is O. 

Specifies that the application running in the 
window take control of the keypad. The 
default is false. 

Specifies that autorepeat be enabled. The 
default is On. 

Specifies that dxterm changes the logical 
display size to match the window size when 
the user changes the window size. The 
default is Off. 

Specifies that the dxterm window 
automatically resize itself to match the 
logical display size whenever the logical 
display size changes. Note that this may 
interfere with other windows on the display. 

Specifies that autowrap mode be enabled. 
The default is Off. 

Specifies the back arrow key code. This code 
can be delete (0) or backspace (1). The 
default is O. 

Specifies whether dxterm should create a 
pixmap to allow graphics to be redrawn when 
the window is exposed. The default is On. 

Specifies how many lines can be scrolled at 
once. The dxterm application never scrolls 
more than the total number of lines on the 
screen at once. The default is 1000. 

Specifies the font used for the "big" font set. 
The default is -*-Terminal-*-*-*--18-*-*­
*-*-*-*-*. 

Controls the number of bit planes used for 
graphics; 2 planes are needed for VT240 
emulation and 4 planes for VT340 emulation. 
The default is 0, which means to use 2 planes 
on systems with fewer than 8 hardware 
planes, and 4 planes on systems with 8 or 
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columns 

condensedFont 

controlQSHold 

couplingHorizontal 

couplingVertical 

cursorBlinkEnable 

cursorStyle 

eightBitCharacters 

fontSetSelection 

geometry 

iconName 

iconName Width 
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more hardware planes. 

Specifies the width of the logical display in 
columns. The default is 80. 

Specifies that the condensed font should be 
used. The default is to display the normal 
font (Oft). 

Specifies that the Ctrl-S and the Ctrl-Q keys 
hold and release the display. The default is 
On. 

Specifies whether the window moves 
horizontally to follow the text cursor when 
the cursor moves outside the window. In this 
way, the cursor is always contained in the 
window. The default is Off. 

Specifies whether the window moves 
vertically to follow the text cursor when the 
cursor moves outside the window. In this 
way, the cursor is always contained in the 
window. 

Specifies whether the cursor blinks. Specify 
on for a blinking cursor or off for one that 
does not blink. The default is On. 

Specifies the cursor style. Specify 0 for a 
block cursor or 1 for an underline cursor. 
The default is O. 

Specifies that 8-bit characters are used in the 
VT300 terminal modes. If not selected, 7 -bit 
NRCS characters are used. The default is 
On. 

Specifies which font is used. Specify 1 for 
little and 0 for big. The default is 1. 

Specifies the width,length, and location of the 
dxterm window. This is the· same as the 
-geometry command line option. 

Specifies the name in the icon box. 

Specifies the width of the name in the icon 
box. 



iconic 

keyboardDialect 

IittleFontSetName 

dxterm (1X) 

Specifies whether the dxterm window is 
initialized as an icon. 

Selects the 7 -bit national replacement 
character set (NRCS). The choices are: 
North American (0), Flemish (1), French 
Canadian (2), British (3), Danish (4), Finnish 
(5), Austrian/German (6), Dutch (7), Italian 
(8), Swiss French (9), Swiss German(10), 
Swedish (11), Norwegian (12), 
Belgian/French (13), Spanish (14), 
Portuguese (15). The default is o. 
Specifies the font used for the "little" font 
set. The default is -*-Terminal-*-*-*--14-*­
*-*-*-*-*-* 

lockUDK Specifies that changes to UDK definitions are 
prevented. The default is Off. 

lockUserFeatures Specifies that changes to user features are 
prevented. The default is Off. 

macrographReportEnable Specifies that the ReGIS macrograph report 
command is enabled. The default is Off. 

marginBellEnable Specifies that the margin bell is turned on. 
The default is Off. 

newLineMode Specifies whether line-feed or newline mode 
is turned on. The default is line-feed mode. 

openQuoteTiideKey Specifies the mapping of the tilde key ('-). 
This mapping can be either ApostropheTilde 
(0) or Escape (1). The default is O. 

periodCommaKeys Specifies the mapping of the period and 
comma keys. This mapping can be either 
PeriodComma (0) or GreaterLessThan (1). 
The default is o. 

responseDA Specifies the response to a Device Attributes 
(terminal ID) request. The terminal ID can 
be VT100 (0), VTIOI (1), VTI02 (2), VT125 
(3), VT220 (4), VT240 (5), VT320 (6), 
VT330 (9), VT340 (7), or DECterm (8). The 
default is 8. 

reverse Video Specifies that dxterm reverse the color 
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rows 

saveErasedLines 

saveLinesOffTop 

screenMode 

scroll Horizontal 

scrollVertical 

shareColorMapEntries 

statusDisplay Enable 

terminalDriverResize 

terminalMode 

textCursorEnable 

title 

transcriptSize 

userPreferenceSet 
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values for foreground and background. The 
default is Off. 

Specifies the height of the logical display in 
rows. The default is 24. 

Specifies whether dxterm should scroll lines 
into the transcript instead of erasing them. 
The default is On. 

Specifies that a transcript of lines be saved 
off the top of a scrolled display. The default 
is On. 

Specifies the screen mode. The screen mode 
can be dark on light or light on dark. The 
default is light on dark. 

Specifies that a horizonal scroll bar be 
displayed in the dxterm window. 

Specifies that a vertical scroll bar be 
displayed in the dxterm window. 

Controls whether DECterm uses shared, 
read-only color map entries for graphics. The 
default is Off, but the option is forced on if 
the hardware color map is read-only. 

Specifies that the status line be displayed. 
The default is false. 

Specifies whether changing the size of the 
logical display changes the size known to the 
terminal driver, and vice versa. The default 
is On. 

Specifies the terminal operating mode. The 
terminal operating mode can be VT52 (0), 
VT100 (1), VT300_7bit (2), VT300_8bit (3) 

Specifies that the text cursor be enabled. 

Specifies the name in the title bar. 

Specifies the maximum number of lines that 
can be recorded off the top of the display. 
The default is 500. 

Specifies the user preference set to DEC (0) 



Files 

warningBellEnabJe 

-/.Xdefaults 
-/default.DECterm 

dxterm (1X) 

or ISO (1). The default is o. 
Specifies that the warning bell be turned on. 
The default is On. 

/usr/lib/Xl1/app-defaults/DXtenn 
-/.DXterm 

See Also 
X(1X), dxwm(1X), DECwindows Desktop Applications Guide 

For descriptions of VT320, ReGIS and sixel commands, refer to the 
DECtenn Text and Graphics Programming manuals. These are not part of 
the UWS documentation set; they must be ordered separately. 

Commands 1-103 



dxue(1X) 

Name 
dxue - DECwindows user executive 

Syntax 
dxue [ options ] 

Description 
The dxue command provides a window that lets you access the UL TRIX 
programming environment and DECwindows applications. In addition, you 
can expand the selection of commands by modifying existing or adding new 
dxue menus. 

When started, dxue creates a text file in your home directory named 
.ue_profile. When you make modifications to the dxue interface, dxue 
records those changes in this file. 

Options 

-bd color 

-bg color 

-d dispname 

-display dispname 

-fg color 
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Specifies the color of the window's border (color 
displays only). The default is specified by means of 
the Session Manager's Customize Window dialog 
box. 

Specifies the color of the window's background 
(color displays only). The default is specified by 
means of the Session Manager's Customize Window 
dialog box. 

Specifies the display screen on which dxue displays 
its window. If the display option is not specified, 
dxue uses the display screen specified by your 
DISPLAY environment variable. The display option 
has the format hostname:number. Using two colons 
(::) instead of one (:) indicates that DECnet is to be 
used for transport. The default is :0. For more 
information, see X(1X). 

This option is the same as the -d option. 

Specifies the color of the window's foreground 
(color displays only). The default is specified by 
means of the Session Manager's Customize Window 
dialog box. 



-fnfant 

-geometry 

Main Window 

dxue(1X) 

Specifies the font used when displaying text. 

Specifies the width, length, and location of the dxue 
window. If the geometry option is not specified, 
dxue uses default values. The geometry option has 
the format [width][xlength][x][y]. For more 
information about the screen coordinate system, see 
x(1X). 

In the dxue window, the Full Directory Path field displays the name of your 
current default directory. The current directory appears in italics in the 
Directories list box. You can change directories by selecting a directory 
name from the Directories list box. The Filter field contains the file name 
pattern to which the files shown in the Files subwindow conform. An empty 
Filter field indicates that all files in the current directory are displayed. The 
current directory and its displayed files are called the current view. 

There are three methods for performing file operations. You can select one 
or more files and then choose one of the items from the Files menu to apply 
to those files. You can also position the pointer on a file name and press 
MB2 (the middle mouse button, unless you have redefined it); you then 
choose a file operation from the pop-up menu that appears. The dxue 
application also defines default operations for various types of files; you 
perform the default operation by positioning the pointer on a file name and 
double-clicking MBl (the left mouse button, unless you have redefined it). 
To view or change the default file operations, choose the Double Click 
Actions ... menu item from the Customize menu. 

Menus 
The dxue window contains the following menus: 

Control 
Customize 
Views 
Files 
Applications 

Control Menu 
The control menu contains the following items: 

Update Updates the current dxue window. 

Select All Selects all the files in the current file view. The files 
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Select None 

Processes ... 

New View 

Save View ..• 

Delete View ••• 

will be displayed in reverse video to indicate that all 
files have been selected. 

Cancels the Select All command. 

Displays a window containing all current processes. 
Kill, Suspend, Continue, and OK buttons are also 
displayed that allow you to kill suspend or continue 
a current process. 

Creates an additional dxue main window. 

Saves your current file view and format. Displays a 
dialog box that prompts for the name of the view. 
In addition, you can select which settings (file 
strings, defaults directories, window sizes, window 
positions, fields, and orders) are saved. 

Displays a dialog box that lets you delete previously 
saved views. 

Save as Startup View Saves your current file view and format as your 
startup view. 

Exit Closes the dxue main window. 

Customize 
The Customize menu contains the following items: 

File Properties... Displays a window for selecting the file properties to 
display in the Files window. The choices are file 
name, protection, link count, owner, size, and 
creation time. As you choose a file property by 
clicking on its toggle button, the Sample field 
displays that property for one of your files. You can 
select the field by which the files are sorted and 
specify the sort order: ascending or descending. 

Edit Menus ••• 

1-106 Commands 

To immediately apply these changes to the files 
currently displayed in the Files subwindow, click on 
the Apply button. To cancel any changes, click on 
the Cancel button. To save the changes, click on the 
OK button. 

Displays a window containing a Menu and Menu 
Items list boxes. The Menu list box contains the 
names of all defined menus. The Menu Items list 
box contains the names of all the defined menu 



Double Click Actions ... 

Views Menu 

dxue(1X) 

items in the menu selected in Menu list box. You 
can create additional menus by entering the name of 
the menu in the New Menu Name field and clicking 
on the Insert button. You can remove menus by 
selecting the name from the list and clicking on the 
Remove button. You can add menu items in the 
same manner. 

To associate a shell string with a menu item, select 
the menu item and type the string in the Associated 
Command or Script field. If you want the file names 
that are selected in the files list to be appended to the 
command when it is executed, click on the Append 
Files to Command selection. Click on the Add to 
Menu Item button to associate the string to the menu 
item. 

To cancel the changes you have made, click on the 
cancel button. To save the changes you have made, 
click on the OK button. 

Displays a dialog box that lets you specify what 
action dxue takes when you double click on a 
particular type of file, such as a directory or a file 
containing C code. Through this dialog box you can 
also define new file types. 

The Views menu contains the following item: 

Startup Displays your startup file view and format. In 
addition, if you saved any views with a different file 
name, these appear as separate menu item in the 
Views menu. 

Files Menu 
The Files menu contains the following items: 

Copy... Displays a window asking for the files you want to 
copy and the destination of each of the selected files. 
Each file is copied to the specified destination. 

Display •.. Displays a window containing a Files list box. Enter 
the name of the files you want to display and click 
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Search ... 

Create Directory ••• 

Move .•• 

Remove ... 

Show Print Jobs .•. 

Print File ... 

Applications Menu 

on the OK button. 

Displays a window asking for the files you want to 
search and the string you want to search for. When 
you enter the file and the string to search for, dxue 
searches for the specified string. 

Displays a window containing a Name list box. 
Enter the name of the directory you want to create. 

Displays a window asking for the files you want to 
move and the destination of each of the selected 
files. Enter the two file names and click on the OK 
button. 

Removes each of the selected files from the current 
directory. 

Displays a dialog box that lets you specify a printer 
queue, and then displays the items on that queue. 

Prints a file. 

The Applications menu contains the following items: 

Calculator Starts a dxcalc application. See dxcalc(lX) for 
more information about the dxcalc application. 

Clock Starts a dxclock application. See dxclock(lX) for 
more information about the dxclock application. 

Mail Starts a dxmail application. See dxmail(1X) for 
more information about the dxmail application. 

Notepad Starts a dxnotepad application. See 
dxnotepad(1X) for more information about the 
dxnotepad application. 

CDA Viewer Starts a dxvdoc application. See dxvdoc(lX) for 
more information about the dxvdoc application. 

Restrictions 
Help is not implemented. 
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X Defaults 

Files 

The dxue application reads the .Xdefaults file during startup and uses the 
appropriate resource specification to customize the appearance or 
characteristics of its displayed dxue window. The format for a resource 
specification in the .Xdefaults file is: 

[name*] resource: value 

name Specifies the application name or the name string that 
restricts the resource assignment to that application or to a 
component of an application. If this argument is not 
specified, the resource assignment is globally available to all 
X applications. 

resource Specifies the resource. 

value Specifies the value that is to be assigned to the resource. 

For more information, see X(1X). 

Because each toolkit-based application can consist of a combination of 
widgets (for example, push buttons and a scroll bar), you can form the name 
string by adding widget class and name identifiers to the string. For further 
information about adding class and name identifiers, see X(1X). 

-/.Xdefaults 
lusr/lib/X ll/app-defaults/Executive 
-I. ue _profile 

See Also 
X(lX), dxwm(lX), dxsession(lX) 
DECwindows User's Guide 
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Name 
dxuil - user interface language compiler for X window system 

Syntax 
dxuil [ options ] file 

Arguments 

file 

Description 

Specifies the file to be compiled through the UIL 
compiler. 

The dxuil command invokes the UIL compiler. The XUI User Interface 
Language (UIL) is a specification language for describing the initial state of a 
user interface for an XUI application. The specification describes the objects 
(menus, dialog boxes, labels, push buttons, and so on) used in the interface 
and specifies the routines to be called when the interface changes state as a 
result of user interaction. 

For more information about the UIL compiler, see the Guide to the XUI User 
Interface Language Compiler. 

Options 

-Ipathname 

-m 

-0 file 

-v file 
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Specify this option followed by a pathname, with no 
intervening spaces, to locate include files when the 
include directive is used. This option causes the 
compiler to look for include files in the directory 
specified if the include files have not been found in 
the paths that have already been searched. 

Machine code is listed. This directs the compiler to 
place in the listing file a description of the records 
that it added to the UID database. This helps you 
isolate errors. The default is no machine code. 

Directs the compiler to produce a user interface 
database (UID). By default, UIL creates a UID with 
the name a. u id. The file specifies the filename for 
the UID. No UID will be produced if the compiler 
issues any diagnostics categorized as error or severe. 

Directs the compiler to generate a listing. The file 



-w 

See Also 
X(1X) 

dxuil (1X) 

specifies the filename for the listing. If the -v 
option is not present, no listing is generated by the 
compiler. The default is no listing. 

Specifies that the compiler suppress all warning and 
informational messages. If this option is not present, 
all messages will be generated, regardless of the 
severity. 

Guide to the XUI User Interface Language Compiler 
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Name 
dxvdoc - Compound document viewer 

Syntax 
dxvdoc [ -fformat] [ -0 optionsJtle] [-r] [-w paper_width] [-h 
paper _height] inputfile 

Description 
The dxvdoc command invokes the CDA Viewer, which enables you to view 
the input file on a workstation running DECwindows. If inputfile is not 
specified, dxvdoc reads from standard input. The dxvdoc window 
contains a menu bar with menu items that allow you to view additional 
documents, change processing options, close open documents, or exit. If you 
invoke dxvdoc with no input file argument, you can specify the first 
document using the file selection box. 

Options 

-fformat 

-0 options Jtle 
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Specifies the format of inputfile and invokes an 
appropriate input converter as part of CDA. The 
DDIF, DTIF, and text converters are provided in the 
base system kit. Additional converters can be added 
by the CDA Converter Library and other layered 
products. Contact your system manager for a 
complete list of input formats supported on your 
system. The default format is DDIF. 

Names the file passed to the input converter to 
control specific processing options in that converter. 
Refer to your documentation set for a description of 
converter options. 

The options file has a default file type of 
.cda_options. Each line of the options file specifies a 
format name that can optionally be followed by 
_input or _output to restrict the option to either input 
or output. The second word is a valid option 
preceded by one or more spaces, tabs, or a slash (/) 
and can contain upper- and lowercase letters, 
numbers, dollar signs, and underlines. The case of 
letters is not significant. If an option requires a 



-r 

-w paper _width 

-b paper _height 
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value, then spaces, tabs, or an equal sign can 
separate the option from the value. 

Each line can optionally be preceded by spaces and 
tabs and can be terminated by any character other 
than those that can be used to specify the format 
names and options. The syntax and interpretation of 
the text that follows the format name is specified by 
the supplier of the front and back ends for the 
specified format. 

To specify several options for the same input or 
output format, specify one option on a line. If an 
invalid option for an input or output format or an 
invalid value for an option is specified, the option 
may be ignored or an error message may be 
returned. Each input or output format that supports 
processing options specifies any restrictions or 
special formats required when specifying options. 

Any messages that occur during processing of the 
options file are written to the system standard error 
location. 

Specifies that the CDA Viewer is to override the 
format of the document. If the -r qualifier is not 
specified, the CDA Viewer retains the formatting 
information stored in the document. 

Specifies the paper width in units of characters. Each 
character unit translates to 720 centipoints (7200 
centipoints per inch or 10 characters per inch 
horizontally). The -w qualifier always specifies the 
fallback formatted document page width to be used 
when the -r (override format) qualifier is specified or 
when the document has no inherent format. If the -w 
qualifier is not specified and if the document has no 
inherent format, the default width is 85 characters, 
which is equivalent to the default page width of 8.5 
inches. 

Specifies the paper height in units of characters. 
Each character unit translates to 1200 centipoints 
(7200 centipoints per inch or 6 characters per inch 
vertically). The -h qualifier always specifies the 
fallback formatted document page height to be used 
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when the -r (override format) qualifier is specified or 
when the document has no inherent format. If the -h 
qualifier is not specified and if the document has no 
inherent format, the default height is 66 lines, which 
is equivalent to the default page height of 11 inches. 

Command line parameters pertaining to XtInitializeO are also supported by 
dxvdoc (for example, -d node::O). 

See Also 
cdoc( 1), vdoc( 1) 
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Name 
dxwm - DECwindows window manager 

Syntax 
dxwm [ options] 

Description 
The dxwm window manager manages the location and size of application 
windows on the screen. Using dxwm, you can move windows, resize 
windows, change the order of windows in the window stack, shrink windows 
to icons, and expand icons into windows. The window manager also works 
with applications to assign input focus to windows. 

Appearance 
When it starts up, dxwm displays an icon box. The icons in the box 
represent application windows. A dim icon represents a window that is 
displayed on the screen. A bright icon represents a window that is not 
displayed. 

The window manager also places a banner on each application window. The 
banner consists of buttons that perform window management functions. If an 
application does not support certain window management functions, its 
banner does not have the buttoms that perform those functions. 

From left to right, the banner buttons are: 

Shrink-to-icon button Shrinks the window into a brightened icon in the 
icon box. 

Title bar Displays the application name or other application­
specific information and moves the window around 
the screen. 

Push-to-back button Changes the window's order in a stack of 
overlapping windows. 

Resize button Changes the size of the window. 

One window's title bar might be highlighted, to indicate that the window has 
input focus. (The window with input focus is the window to which keyboard 
input is sent). 
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If sticky windows have been specified (see the following sections Sticky 
Windows and X Defaults), shading appears on the stacking button of the 
sticky windows. By default, no windows are sticky. 

Functionality 
Mouse button I (MBl), the left button for most users, controls all window 
manager functions. To use dxwm, you must know how to use MB 1 to click 
on an object, double click on an object, and drag the pointer. 

To click on an object (such as one of the buttons previously described under 
Appearance), position the pointer over the object, and then press and 
immediately release MB 1. Try not to move the mouse when MB 1 is down. 

To double click on an object, click on the object twice in quick succession 
without moving the mouse. 

To drag the pointer, press and hold MBl, move the mouse until the pointer is 
at the desired location, and then release MB 1. 

Moving Windows 
To move a window, position the pointer on the title bar. Press and hold down 
MBI. A window outline appears. Move the mouse while continuing to hold 
down MB 1, dragging the outline to the new location. When you release 
MB 1, the window shifts to the new position. 

The move operation affects an unsticky window more than a sticky window 
by changing its stack position and input focus. An unsticky window moves to 
the top of the window stack (so that it is unobscured by other windows at the 
new location); a sticky window's position does not change. An unsticky 
window also acquires input focus (if it is one that ever takes input); a sticky 
window does not acquire focus. 

To cancel the move operation while you are dragging the window outline, 
click any other mouse button before releasing MB 1. 

Shrinking Windows Into Icons 
To shrink a window to its icon, click on the shrink-to-icon button; dxwm 
removes the window and brightens the associated icon in the icon box. (For 
another way to shrink a window to its icon, see the section Icon Box 
Operations. ) 

To cancel the shrink-to-icon operation, click any other mouse button before 
releasing MB 1. 
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Expanding Icons Into Windows 
To expand an icon into a window, click (or double click) on the icon. The 
window opens at its previous screen location and at the top of the window 
stack, while the icon dims. If the window ever takes keyboard input, it now 
acquires input focus, unless the user specified otherwise (see the section X 
Defaults). 

To cancel the expand operation, click any other mouse button before 
releasing MB 1. 

Resizing Windows 
To adjust the size of one side of a window, point to the resize button. Press 
and hold MB 1. Drag the pointer toward the side you want to adjust. When 
the pointer touches the border on that side, dxwm clamps the border; the 
border's outline now follows the pointer as you move it around the screen. 
When the border outline is in the desired new location, release MB 1. The 
window adjusts to the newly sized border. 

While dragging the pointer to resize the border, you can change your mind 
and resize the opposite side instead. Drag the pointer past the opposite 
border. The original border outline snaps back and dxwm clamps the more 
recently crossed border. 

To adjust two sides of a window, as if by manipulating the comer, drag the 
pointer to touch each adjacent border in tum. 

The resize operation affects unsticky windows more than it affects sticky 
ones, by changing their stack position and input focus. During the resize 
operation, an un sticky window moves to the top of the window stack. If the 
un sticky window ever accepts keyboard input, it acquires input focus. A 
sticky window retains its position in the window stack and does not acquire 
input focus. 

To cancel the resizing operation, click any other mouse button before 
releasing MB 1. 

Changing A Window's Stack Position 
Windows are unsticky by default. To raise an unsticky window to the top of 
the window stack, where it is not obscured by other windows, click almost 
anywhere in the window (except on the shrink-to-icon button or the push-to­
back button). To lower an un sticky window to the bottom of the stack, 
where it is obscured by windows with which it shares a portion of the screen, 
click on its push-to-back button. 
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To change a sticky window's position in the window stack" you must use the 
push-to-back button, since a sticky window retains its position in the window 
stack when you click elsewhere. To raise a partially obscured sticky window 
to the top of the window stack or to lower an unobscured sticky window to 
the bottom of the stack, click on the window's push-to-back button. 

Making Windows Sticky 
To make an unsticky window sticky, press and hold down the Shift keyboard 
key and click in the push-to-back button of the window. The window moves 
to the bottom of the window stack and becomes sticky. Partial shading 
appears in the push-to-back button to indicate the window's stickiness. 

Making Windows Unsticky 
To make a sticky window unsticky, hold down the Shift keyboard key and 
click on the push-to-back button. The stacking operation for the sticky 
window is performed (the window is raised or lowered in the window stack, 
depending on whether or not it was obscured), but the window then becomes 
unsticky and henceforth has un sticky behavior. The push-to-back button's 
partial shading, which indicated stickiness, now disappears. 

Assigning Input Focus 
The window manager cooperates with applications to assign input focus, in a 
way that varies according to the user action, the situation, and the 
application. You can give an application input focus by clicking on its title 
bar, clicking into its window, or expanding its icon. Unsticky windows 
also acquire input focus when you move or resize them. 

When you click on the title bar to assign input focus to a window, clicking 
leaves the insertion point for input where it was before you clicked. This lets 
you give a window input focus without disturbing its contents. In contrast, if 
you click into the window on a field where input is possible, clicking places 
the insertion point for input wherever you clicked. This lets you give input 
focus and reset the insertion point in one action. 

Icon Box Operations 
The icon box is the window manager's application window. Like other 
application windows, it has a banner, whose buttons allow the icon box to be 
moved, resized, lowered, or raised. But unlike other application windows, 
the icon box cannot be shrunk to an icon: where would its icon go? Instead, 
the icon box has a tidy button, described in a later paragraph. 
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The icon box contains icons for application windows. Most (but not all) 
application windows store icons in the icon box. Icons can be large or small, 
according to user preference (see the section X Defaults); they are small by 
default. Each icon contains a picture and some text. The picture for an icon 
looks like the picture in the shrink-to-icon button of its application window. 
Dim icons represent application windows that are currently displayed; bright 
icons represent those that are not displayed, but are stored in the icon box. 

Icons provide quick access to application windows. Clicking in a bright icon 
expands it into an application window; clicking in a dim icon removes the 
window, so that just the brightened icon is displayed. Double-clicking in any 
icon, bright or dim, brings its application window to the top of the window 
stack. If the window accepts input, this action also gives it input focus. 

You can move icons around within the icon box to position them 
conveniently (but you cannot move them out of the icon box). To move an 
icon, position the pointer over the icon and drag the outline that appears to 
the new location, as if moving a window by its title bar. Icons can overlap: 
icons on the right overlap icons on the left. Icon pictures, however, cannot 
overlap. 

When adding new icons to the icon box, dxwm places them in left-to-right 
and top-to-bottom order. When the icons do not fit in the icon box, dxwm 
creates horizontal or vertical scroll bars, or both. You can then scroll the 
icon box to view all of the icons. When adding a new icon, dxwm attempts 
to place it at the first position that is visible in the icon box and that has 
enough space to accommodate the icon without obscuring others. If no such 
position is available, dxwm places the icon at the first position with enough 
space and scrolls the icon box to make the position visible. 

The tidy button of the icon box is in the position usually occupied by a 
window's shrink -to-icon button. The tidy button rearranges the icons so that 
they are arranged one next to another. 

X Defaults 
Read X( IX) for a general description of the format and function of the 
.Xdefaults file. The following list describes some dxwm resources you can 
set; the description does not attempt to be complete, or to provide a general 
discussion about resources or the format of resource files. 

Wm*default.sticky 
Specifies whether windows are sticky at startup. A value of true 
causes application windows to be sticky at startup. The default 
value is false. 
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Wm *defauIt.initiaIState 
Specifies whether application windows start up open or as icons. 
The value 1 specifies that windows start up open; the value 3 
specifies that they start up as icons. The default value is 1. 

Wm*default.deiconifyFocus 
Specifies whether windows that accept keyboard input 
automatically acquire input focus when expanded from icons. 
The value true means that windows acquire focus when 
expanded; false means that they do not. The default value is 
true. 

Wm*defauIt.startupFocus 
Specifies whether new windows have input focus when they first 
appear on the screen. The value true means that new windows 
have focus; false means they do not. The default value is false. 

Wm*defauIt.autoFocus 
Specifies whether the window manager tries to assign focus to a 
window when the window with focus goes away (because it is 
shrunk to an icon, for example). The value true means that the 
window manager tries to assign focus to another window; false 
means that it does not automatically assign focus in that 
situation. The default value is true. 

Wm*defauIt.spaceout 
Specifies a limit on mouse movement during a click, to 
distinguish a user's intention to click on an object from the 
intention to drag the object. This helps prevent the window 
manager from mistaking mouse movement due to slight 
unintentional hand movement for intentional mouse motion. 
The units are pixels; the default value is 3 pixels. 

Wm*defauIt.doubleClickTimeout 
Specifies how much time can elapse between the two clicks of a 
double mouse click. If the timeout value elapses after one click, 
the next click is considered a separate action. The units are 
milliseconds; the default value is 500 milliseconds. 

Wm*defauIt.titleTimeout 
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Specifies how long MB 1 can be pressed in the title bar (with no 
mouse motion) before dxwm treats the action as the start of a 
drag rather than as a click. This timeout distinguishes a title bar 
click (which gives input focus) from the start of a title drag 
(which repositions the window). Once the time-out value elapses, 
any mouse motion while MB1 is down adjusts the position of 
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the window (even if the motion is less than the value of 
Wm*default.spaceout). The units are milliseconds; the default 
value is 500 milliseconds. 

Wm*default.flash 
Specifies whether to display a flashing outline as a visual cue 
when shrinking a window to an icon or expanding an icon to a 
window. The flashing outline shows boxes of decreasing size 
(leading from a window to its icon) or increasing size (leading 
from an icon to its window). The value true causes flashing 
outlines to appear; false suppresses them. The default is false. 

Wm*default.titleFont 
Specifies the font for the title bar text. The DECwindows default 
font is the default value for this resource. 

Wm*default.iconFont 
Specifies the font for the icon text. The DECwindows default 
font is the default value for this resource. 

Wm*default.geometry 
Specifies the size and location of the icon box. The format of 
the geometry string is described in XCIX). The default 
placement of the icon box is at screen coordinates 0,0; its height 
is 46, and its width is approximately the width of the screen. 

Wm*ScroIlW.forceBars 
Specifies whether scroll bars are always displayed in the icon 
box. The value true means that scroll bars are always displayed 
in the icon box; false means that they are displayed only when 
needed. The default value is false. 

Wm*ScroIlW.scroIlTopSide 
Specifies where the horizontal scroll bar appears in the icon box. 
The value true places the horizontal scroll bar at the top of the 
icon box; false places it at the bottom. The default value is false. 

Wm*ScroIlW.scroIlLeftSide 
Specifies where the vertical scroll bar appears in the icon box. 
The value true places the vertical scroll bar on the left side of the 
icon box; false places it on the right side. The default value is 
false. 

Wm*WmForm.borderColor 
Specifies the color of the thin outer border of each managed 
window. The default value is white. 
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Files 

Wm*WmForm.foreground 
Specifies the color of the thick inner border of each managed 
window and the borders between buttons. The default value is 
black. 

Wm*WmlconForm.iconStyle 
Specifies whether icons are small or large by default. The value 0 
specifies small icons; the value 1 specifies large ones. The 
default value is O. 

You can specify that the default values for WmForm and WmIconForm 
apply to windows of only a specific class, and not to all application windows. 
To do this, substitute the class of the application for WmForm or 
WmIconForm when specifying the resource. For example, the following 
lines specify that icons are small by default, but that the icon for the Notepad 
application is large: 

Wm*WmForm.iconStyle: 0 
Wm*Notepad.iconStyle: 1 

Resource settings can be overridden by command line options; see Guide to 
the XUI Toolkit Intrinsics: C Language Binding for a description of how to 
do this. Resources standard to all applications, including dxwm, are 
described in X(1X). 

/usr/lib/Xl1/app-defaults/Wm 

See Also 
X(1X), DECwindows User's Guide, Guide to the XUI Toolkit Intrinsics: C 
Language Binding 
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Name 
resize - reset TERMCAP with the current window size 

Syntax 
resize [ options ] 

Description 
The resize command prints on its standard output the TERM and TERMCAP 
commands for the current window. When executed, the resize command 
resets the environment of the current shell. 

However, the resize command should never be executed directly, but should 
be aliased in the .cshrc file to cause the C shell to execute the commands 
(see EXAMPLES). 

Options 

-s Specifies that Sun terminal escape sequences are used. Using Sun 
terminal sequences resizes a window appropriately when a new row 
and column size are specified. 

-u Specifies that the commands be formed appropriately for the Bourne 
shell rather than the C shell. 

Restrictions 
The -u option must appear before the -s option if both are specified. 

Examples 

Files 

alias xs 'set noglobi eval 'resize'iunset noglob' 
alias xrs 'set noglob; eval 'resize -s \!\*';unset noglob' 

Each alias, when executed as a command, resets the environment of the 
current shell. 

/etc/termcap 
.... /.cshrc 
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See Also 
xterm(lX) 
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Name 
x - A network -transparent window system 

Description 
The X Window System, which consists of an X Server and a variety of X 
client applications, is network transparent, runs on workstations, and provides 
the capabilities to design a variety of user interface styles. Within the X 
Window System, the X Server distributes user input to and accepts output 
requests from the various X client programs, which can be located either on 
the same machine or elsewhere on the network. 

The X Window System supports overlapping windows, fully recursive 
subwindows, and text and graphics operations within windows. One of the X 
window managers can be used to manipulate existing windows. 

The command that executes the X Server usually is specified in the 
/ et c / tty s file and, therefore, is automatically running when your system 
is in multiuser mode. 

By default when you log in, only programs running on your local machine or 
those machines listed in a trusted-hosts database file are allowed to interact 
with the X Server that is connected to your display. To allow programs 
running remotely to interact with your display, use the xhost(1X) 
command. 

See the Xfmb(8X) and Xqvsm(8X) reference pages for more detailed 
information on starting and running the X servers. 

The Display Option 
Many X-based applications take a display option. The display option has one 
of the following formats: 

-d[isplay] hostname 

The display option specifies the display screen on which the X Server is to 
accept requests from X clients. If the display option is not specified, X uses 
the display screen specified by your DISPLAY environment variable. The 
display option has the format hostname:number. Using two colons (::) 
instead of one (:) indicates that DECnet is to be used for transport. 

hostname Specifies the name of the host machine on which the 
display is connected. You can specify the name 
unix or leave the field blank to use UNIX IPC, or 
the name of your host machine to use TCP. 
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number 

Window Geometry 

Specifies the number of the display on that host 
machine. 

The default is :0. 

Most X client applications let you specify the size and position of the 
application window with the geometry option. The geometry option has the 
following format: 

[width] [xlength] [x] [y] 

width Specifies the number of pixels the window spans 
horizontally. 

length Specifies the number of pixels the window spans 
vertically. 

x Specifies the x screen coordinate (pixel value) for the 
starting comer of the window. 

y Specifies the y screen coordinate (pixel value) for the 
starting comer of the window. 

Depending on the comer of the screen from which each coordinate value is 
an offset, the x and y coordinates must be preceded by a plus (+) or a minus 
(-). The following lists the four screen comers and the required positive or 
negative state for the x and y coordinates when you create a window with 
respect to that comer. 

Upper left comer +x +y 
Lower left comer +x -y 
Upper right comer -x +y 
Lower right comer -x -y 

If the geometry option is not specified, you can position the window with the 
mouse pointer and size it with one of the mouse buttons. For sizing 
information specific to an application, see the reference page for that 
application. 

Most X client applications read options (such as font and border WIdth) to 
control the sizing of their initial window. For information about options 
specific to an application, see the reference page for that application. 
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Colors And Fonts 
Many X client applications let you specify colors for background, border, 
text, and so on. A color specification can be given either as an English name 
(see /usr/lib/rgb.txt for defined names), or three hexadecimal values for the 
red, green, and blue components, in the format #RRGGBB. 

Many X client applications also let you specify the font in which text is 
displayed. By default, the available fonts can be found in subdirectories of 
the /usr/lib/X II/fonts directory. 

X Defaults 
Most X -based applications read the .Xdefaults file during startup and use the 
appropriate resource specifications to customize the appearance or 
characteristics of their windows. The format for a resource specification in 
the .Xdefaults file is: 

[name*] resource: value 

name Specifies the application name or the name string that 
restricts the resource assignment to that application or to a 
component of an application. If this argument is not 
specified, the resource assignment is globally available to all 
X applications. 

resource Specifies the X resource. 

value Specifies the value that is to be assigned to the resource. 

Because each toolkit-based application can consist of a combination of 
widgets (for example, push buttons and a scroll bar), you can form the name 
string, in addition to the application name, by adding widget class and name 
identifiers to the string. 

In most cases, an asterisk (*) should be used as a delimiter. An asterisk is 
similar to a wildcard character because it specifies that the definition applies 
even if any additional names and classes are omitted. A period delimiter (.) 
indicates an absolute widget pathname. When using a period, if you do not 
specify all widgets in the path, the specification will not work. 

When you add a widget class identifier to the name string, you make the 
resource available to every occurrence of that widget in the application. For 
example, the following assigns the background color of every push button in 
the dxmai 1 window to green: 
dxmail*PushButton*background: green 
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When you add a widget name identifier to the name string, you make the 
resource available to the specific widget (component) with that name in the 
application. For example, the following assigns the background color of the 
Exit push button in the dxmail window to green: 
dxmail*Exit*background: green 

This example adds a name identifier (Exit) to the string. 

The application name does not have to be part of the string. For example, 
the next two specifications assign the background color of button boxes. The 
first assigns all button boxes with the same class identifier in all toolkit-based 
applications to blue. The second assigns all button boxes with the name 
tocButtons in all toolkit-based applications to red: 
*ButtonBox*background: blue 
*ButtonBox*tocButtons*background: red 

For a complete description of the general widget classes, the core attributes 
for each widget, and the widget-specific attributes see the Intro to the UWS 
Environment. 

NOTE 

Default values may be modified by specific applications. 

For information about the resources that can be specified for each X client 
application, see the reference page for that application. 

The following is a sample .Xdefaults file that can be used as a template. 

iiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiii#i#illliiliii 
i 
i general defaults 
i 
ililiiiiiiiiiiiiiiiiiiiiiiiiiiliiiii####iiii######I#i##I#i###### 

*Font: 
*Text*Font: 
*Pushbutton.Font: 
*titlebar.Font: 

helvetica bold12 
helvetica12 
helvetica bold12 
helvetica-bold12 

*ButtonBox.borderWidth: 1 
*ButtonBox.hSpace: 8 

*ButtonBox.Command.borderWidth: 0 
*ButtonBox.Command.internalWidth: 1 
*ButtonBox.Command.internalHeight: 1 

# 
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# dxmail 
# 

dxmail*debug: on 
dxmail*tocGeometry: 510x284+0+19 
dxmail*viewGeometry: 510x460+0+323 
dxmail*folders.Pushbutton.MarginWidth: 2 
dxmail*folders.Pushbutton.MarginHeight: 2 
dxmail*PrintCommand: enscript >2 /dev/null > /dev/null 

dxmail*ButtonBox*Font: 

Dxterm*fontSetName: 6x13 
Dxterm*saveLinesOffTop: on 
Dxterm*screenMode: true 
Dxterm*autoWrapEnable: on 
Dxterm*autoRepeatEnable: on 
Dxterm*autoResize: on 
Dxterm*scrollVertical: on 

# 
# Session Manager 
# 

helvetica bold12 

sm. create terminal: 
sm. startup_state: 

1 
iconified 

# 
#wm 
# 

wm*sticky: 
wm*border: 

Key Bindings 

true 
#OOffff 

X(1X) 

Many X-based applications let you specify key-actions bindings for text input 
and editing operations. The DECwindows user interface provides basic text 
editing operations. In these text editing operations, a word is considered to 
be any contiguous string of characters that does not contain a word break 
character. Word break characters are as follows: space, tab, and line 
terminators. In addition, any contiguous string of identical word break 
characters (such as three spaces) is considered to be a word. The default text 
editing operations for all text windows are as follows: 

Right arrow Moves the cursor one character to the right. In 
a single-line field, the cursor does not move 
when positioned at the end of the line. In a 
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Left arrow 

Up arrow 

Down arrow 

Fll, F14 

F12 

SHIFT/FI2 

F13 

SHIFT/F13 

DELETE 

SHIFT/DELETE 

multi-line field, the cursor moves to the first 
position of the next line. 

Moves the cursor one character to the left. In a 
single-line field, the cursor does not move 
when positioned at the beginning of the line. 
In a multi-line field, the cursor moves to the 
last position of the previous line. 

In a multi -line field, moves the cursor up one 
line. 

In a multi-line field, moves the cursor down 
one line. 

Reserved. 

Positions the cursor at the beginning of the 
line. 

Positions the cursor at the end of the line. 

Deletes the characters to the left of the cursor 
up to and including the beginning of the word, 
and shifts to the left all text to the right of the 
deleted character. 

Deletes the characters to the right of the cursor 
up to and including the beginning of the word, 
and shifts to the right all text to the right of 
the deleted character. 

Deletes the character before the cursor, and 
moves all text to the right of the deleted 
character one space to the left. DELETE works 
the same way in both insert and overstrike 
mode. When there is a selection, DELETE 
removes the selection but does not place it in 
the clipboard. 

Deletes the character after the cursor, and 
moves all text to the right of the deleted 
character one space to the left. In overstrike 
mode, SHIFT /DELETE deletes the character 
under the block cursor. 

A dialog box has one text insertion cursor, even if it has multiple text 
windows. Keys in a dialog box with multiple text windows take on the 
following additional actions: 
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SHIFT/TAB 

RETURN 

ENTER 

SHIFT/RETURN 
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Moves the cursor from the current field to the 
next field. If any text exists in the new field, 
it is automatically selected for pending delete. 

Moves the cursor from the current field to the 
previous field. If any text exists in the new 
field, it is automatically selected for pending 
delete. 

Activates the default push button (if there is 
one) in the dialog box. 

Activates the default push button (if there is 
one) in the dialog box. 

Activates the Cancel push button (if there is 
one) in the dialog box. 

You can customize the basic text editing functions for text windows with the 
translations resource specified in the This resource should be specified as: 

*Text.translations: key specification 

Each key specification listed with the translations resource assigns an editor 
command to a named key or mouse combination and has the format: 

key: function 

key Specifies the key or mouse button that is used to 
invoke the named function. 

function Specifies the function to be invoked when the named 
key is pressed. 

You can specify any of the following control keys (their abbreviations are in 
parentheses ): 

Ctrl (c) 

Lock (1) 

Meta (Compose Character) (m) 

Shift (s) 

You can specify the following mouse buttons: 

Btnl (by default, the left mouse button) 

Btn2 (by default, the middle mouse button) 

Btn3 (by default, the right mouse button) 
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You can assign the following actions to mouse buttons: 

Down Action is invoked when the button is pressed. 

Up Action is invoked when the button is released. 

PtrMoved Action is invoked when the mouse button is down 
and the pointer is moved. 

You can specify the following functions: 

backward-character 

backward-kill-word 

Moves backward one character. 

Kills the word before the insertion point. This text 
can be recovered with the unkill function. 

backward-paragraph Moves backward one paragraph. 

backward-word Moves backward one word. 

beginning-of-file Moves to the beginning of the text. 

beginning-of-Iine Moves to the beginning of the current line. 

delete-next-character Deletes the character after the insertion point. 

delete-next-word Deletes the word after the insertion point. 

delete-previous-character 
Deletes the character before the insertion point. 

delete-previous-word Deletes the word before the insertion point. 

delete-selection 

end-of-file 

end-of-Iine 

extend-adjust 

extend-end 

extend-start 

forward-character 

forward-paragraph 

forward-word 

insert-file 

kill-selection 

kill-to-end-of-line 
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Deletes the selection. 

Moves to the end of the text. 

Moves to the end of the current line. 

Adjusts the extension of the selected text. 

Ends the extension of the selected text. 

Begins the extension of the selected text. 

Moves forward one character. 

Moves forward one paragraph. 

Moves forward one word. 

Inserts a file into the text. 

Kills the selection. This text can be recovered with 
the unkill function. 

Kills from the insertion point to the end of the line. 
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This text can be recovered with the unkill function. 

kill-to-end-of-paragraph 

kill-word 

newline-and-backup 

newline-and-indent 

newline 

next-line 

next-page 

previous-line 

previous-page 

redraw-display 

scroll-one-line-down 

scroll-one-Iine-up 

select-adjust 

select-all 

select-end 

select-start 

select-word 

stuff 

unkill 

Kills from the insertion point to the end of the 
paragraph. This text can be recovered with the 
unkill function. 

Kills the word after the insertion point. This text 
can be recovered with the unkill function. 

Creates a new paragraph, leaving the insertion point 
on the previous one. 

Creates a new paragraph with the same indentation 
as the current one. 

Creates a new paragraph. 

Moves down one line. 

Moves to the next screen of text. 

Moves up one line. 

Moves to the previous screen of text. 

Repaints the window. 

Scrolls the text down one line. 

Scrolls the text up one line. 

Adjusts the selection. 

Selects all the text. 

Ends the selection. 

Begins the selection. 

Selects the word the insertion point is in. 

Inserts the text that was last selected from any 
window. 

Inserts the text that was last killed. (There is no way 
to get back text that was deleted.) 

A function specification can also include a character in single quotation 
marks ora string in double quotation marks. A string in quotation marks 
instructs the application to insert the specified string into the file. For 
example, the following function instructs the application to insert the string 
"abcdef' into the text, insert the current selection into the text, and then insert 
the letter q when CTRL/Q is pressed. 

Commands 1-133 



X(1X) 

cq: "abcdef" stuff 'q' 

A sample set of key bindings in the .Xdefaults file is as follows: 

41= 

41= toolkit text bindings 
41= 

set-insertion-point() select-start() 
*Text.translations:Ctrl<Key>f:forward-character() 
Ctrl<Key>b: backward-character() 
Meta<Key>f: forward-word() 
Meta<Key>b: backward-word() 
Meta<Key>]: forward-paragraph() 
Ctrl<Key> [: backward-paragraph () 
Ctrl<Key>a: beginning-of-line() 
Ctrl<Key>e: end-of-line() 
Ctrl<Key>n: next-line() 
Ctrl<Key>p: previous-line() 
Ctrl<Key>v: next-page() 
Meta<Key>v: previous-page() 
Meta<Key>\<: beginning-of-file() 
Meta<Key>\>: end-of-file() 
Ctrl<Key>z: scroll-one-line-up() 
Meta<Key>z: scroll-one-line-down() 
Ctrl<Key>d: delete-next-character() 
Ctrl<Key>h: delete-previous-character() 
-Shift Meta<Key>d:delete-next-word() 
-Shift Meta<Key>h:delete-previous-word() 
Ctrl<Key>w: kill-selection() 
Meta<Key>y: stuff() 
Ctrl<Key>m: newline() 
Ctrl<Key>l: redraw-display() 
Any<Key>: self-insert() 
Meta<BtnlDown>: extend-start() 
Meta Buttonl<PtrMoved>:extend-adjust() 
Meta<BtnlUp>: extend-end() 
Meta<Btn2Down>: stuff() 

Restrictions 
If options not listed in appropriate X server reference page are used, the 
server may fail. Using invalid options for the X server in the /etc/ttys may 
cause the workstation to behave as if the X server is hung. 
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Files 
-/.Xdefaults 

See Also 
bitmap(IX), dxcalendar(IX), dxcalc(IX), dxcardfiler(IX) dxclock(IX), 
dxmail(1X), dxnotepad(1X), dxterm(1X), dxwm(1X), uwm(1X), xedit(1X), 
xfd(1X), xhost(1X), xload(1X), xmh(1X), xset(IX), xsetroot(IX), 
xwininfo( IX) Xmtb(8X) Xqvsm(8X) 
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Name 
Xmfb, Xcfb - X servers for RISC machines 

Syntax 
Xmfb [ options] 
Xcfb [ options ] 

Description 

The Xmfb command starts the monochrome DECstation server. The Xcfb 
command starts the color DEC station server. 

The command that executes the X Server is usually specified in the 
/ et c / tty s file and, therefore, is automatically running when your system 
is in multiuser mode. Use the xset -q command to query the server for the 
options that are currently set. 

Options 

-anum 

-c 

cnum 

-fnum 

-fc string 

-fn string 

-fp string 

-help 

-r 

r 

-s num 

Sets the mouse acceleration value to the specified 
number of pixels. The default is 4. 

Turns off key clicking. 

Sets the key click volume to the specified number 
(0-100). The default is 20. 

Sets the bell volume to the specified number (0-7). 
The default is 3. 

Sets the default cursor font. The default is cursor. 

Sets the default text font. The default is fixed. 

Sets the default font path. The default is 
/usr/lib/dwf 

Displays the X Server usage message. 

Turns off automatic repetition of keyboard key 
characters. 

Turns on automatic repetition of keyboard key 
characters. The default is on. 

Sets the screen-saver timeout value to the specified 
number of minutes. The default is 10. 
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-tnum 

v 

-v 

-pnum 

-wp color 

:num 

Sets the mouse threshold in pixels. The mouse will 
accelerate only if the threshold is exceeded. The 
default threshold is 4. 

Specifies that a blank screen is used for the screen­
saver. The default is on. 

Specifies that a pattern (noblank) screen is used for 
the screen-saver. 

Determines the period to change the background 
pattern of the . screen-saver to avoid bum-in. The 
default is 10 seconds. 

Sets the color of white pixels as a named color or a 
number followed by six hexadecimal digits (color 
displays only). 

On a multi-head system, specifies the head on which 
the server is run (0 or 1). The default is O. 

Device dependent, vendor specific options. 

-bp color Sets the color of black pixels for the screen. 

-wp color 

-dpi num 

-dpix num 

-dpiy num 

Sets the color of white pixels for the screen. 

Sets the dots per inch for the x and y coordinates. 

Sets the dots per inch for the x coordinates. 

Sets the dots per inch for the y coordinates. 

Restrictions 

Files 

If options not listed in this reference page are used, the server may fail. 
U sing invalid options for the X server in the /etc/ttys may cause the 
workstation to behave as if the X server is hung. 

-/.Xdefaults 

See Also 
bitmap(1X), dxcalc(1X), dxcalendar(lX), dxcardfiler(1X) dxclock(1X), 
dxmail(1X), dxnotepad(1X), dxterm(1X), dxwm(IX), uwm(1X), xedit(1X), 
xfd(1X), xhost(1X), xload(1X), xmh(1X), xset(1X), xsetroot(1X), 
xwininfo( IX) X( IX) 
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Name 
Xqvsm, Xqdsg, Xgb - X servers for V AX machines 

Syntax 
Xqvsm [ options] 
Xqdsg [ options] 
Xgb [ options] 

Description 

The Xqvsm command starts the monochrome V AXstation 2000, the 
monochrome V AXstation 3100, and the V AXstation II servers. The Xqdsg 
command starts the color V AXstation 2000 server, the color V AXstation 
3100, and the GPX. The Xgb command starts the VAXstation 3520 server. 

The command that executes the X Server is usually specified in the 
/ etc/ttys file and, therefore, is automatically running when your system 
is in multiuser mode. 

Options 

-anum 

-bp color 

-c 

cnum 

-fnum 

-fc string 

-fd num 

-fn string 

-fp string 

-help 

Sets the mouse acceleration value to the specified number 
of pixels. The default is 4. 

Sets the color of black pixels as a named color or a 
number followed by six hexadecimal digits (color displays 
only). 

Turns off key clicking. 

Sets the key click volume to the specified number (0-100). 
The default is 20. 

Sets the bell volume to the specified number (0-7). The 
default is 3. 

Sets the default cursor font. The default is cursor. 

Specifies a screen density number of 75 or 100 dpi. The 
default is 75. 

Sets the default text font. The default is fixed. 

Sets the default font path. The default is /usr / lib/ dwf 

Displays the X Server usage message. 
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Xqvsm(8X) 

-r 

r 

-snurn 

-tnurn 

v 

-v 

-pnum 

-wp color 

:num 

Turns off automatic repetition of keyboard key characters. 

Turns on automatic repetition of keyboard key characters. 
The default is on. 

Sets the screen-saver timeout value to the specified number 
of minutes. The default is 10. 

Sets the mouse threshold in pixels. The mouse will 
accelerate only if the threshold is exceeded. The default 
threshold is 4. 

Specifies that a blank screen is used for the screen-saver. 
The default is on. 

Specifies that a pattern (noblank) screen is used for the 
screen-saver. 

Determines the period to change the background pattern of 
the screen-saver to avoid bum-in. The default is 10 
seconds. 

Sets the color of white pixels as a named color or a 
number followed by six hexadecimal digits (color displays 
only). 

On a multi -head system, specifies the head on which the 
server is run (0 or 1). The default is O. 

Restrictions 

Files 

If options not listed in this reference page are used, the server may fail. 
Using invalid options for the X server in the /etc/ttys may cause the 
workstation to behave as if the X server is hung. 

-/.Xdefaults 

See Also 
bitmap(lX), dxca1c(lX), dxcalendar(lX), dxcardfiler(lX) dxc1ock(lX), 
dxmail(1X), dxnotepad(1X), dxterm(1X), dxwm(1X), uwm(1X), xedit(1X), 
xfd(1X), xhost(1X), xload(1X), xmh(1X), xset(lX), xsetroot(1X), 
xwininfo(1X), X(1X) 
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How to Order Additional Documentation 

Technical Support 
If you need help deciding which documentation best meets your needs, call 800-343-4040 
before placing your electronic, telephone, or direct mail order. 

Electronic Orders 
To place an order at the Electronic Store, dial 800-234-1998 using a 1200- or 2400-baud 
modem from anywhere in the USA, Canada, or Puerto Rico. If you need assistance using the 
Electronic Store, call 800-DIGITAL (800-344-4825). 

Telephone and Direct Mail Orders 

Your Location 

Continental USA, 
Alaska, or Hawaii 

Puerto Rico 

Canada 

International 

Internal * 

Call 

800-DIGITAL 

809-754-7575 

800-267-6215 

Contact 

Digital Equipment Corporation 
P.O. Box CS2008 
Nashua, New Hampshire 03061 

Local Digital Subsidiary 

Digital Equipment of Canada 
Attn: DECdirect Operations KA02/2 
P.O. Box 13000 
100 Herzberg Road 
Kanata, Ontario, Canada K2K 2A6 

Local Digital subsidiary or 
approved distributor 

SSB Order Processing - WMO/E15 
or 
Software Supply Business 
Digital Equipment Corporation 
Westminster, Massachusetts 01473 

* For internal orders, you must submit an Internal Software Order Form (EN-01740-07). 





Reader's Comments ULTRIX WORKSYSTEM SOFTWARE 
Reference Pages 

Sections 1 X and ax 
AA-MA85C-TE 

Please use this postage-paid form to comment on this manual. If you require a written reply 
to a software problem and are eligible to receive one under Software Performance Report 
(SPR) service, submit your comments on an SPR form. 

Thank you for your assistance. 

Please rate this manual: 
Accuracy (software works as manual says) 
Completeness (enough information) 
Clarity (easy to understand) 
Organization (structure of subject matter) 
Figures (useful) 
Examples (useful) 
Index (ability to find topic) 
Page layout (easy to find information) 

Excellent 
o 
o 
o 
o 
o 
o 
o 
o 

Good 
o 
o 
o 
o 
o 
o 
o 
o 

Fair 
o 
o 
o 
o 
o 
o 
o 
o 

Poor 
o 
o 
o 
o 
o 
o 
o 
o 

What would you like to see more/less of! _________________ _ 

What do you like best about this manual? _________________ _ 

What do you like least about this manual? 

Please list errors you have found in this manual: 

Page Description 

Additional comments or suggestions to improve this manual: 

What version of the software described by this manual are you using? 

Nameffitle _________________ Dept. 
Company ______________________ Date 

Mailing Address 
____________ Email ______________ Phone ____________ ___ 
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